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OS X Server 5 helps your users collaborate, communicate, 
share information, and access the resources they need to get 
their work done. While OS X Server indeed provides a variety 
of services, the aim of this guide is to focus on the services 
that facilitate the management of Apple devices.

This lesson begins with a brief introduction of OS X Server 
before moving into the requirements and initial setup of  
OS X Server. This lesson also covers selecting and configur-
ing Secure Sockets Layer (SSL) certificates required for Apple 
device management.

NOTE ▶  Although you can install OS X Server 5.0 on OS X Yosemite, the version 
available from the Mac App Store at the time of this writing is OS X Server 5.1, 
which requires OS X El Capitan 10.11.4. Server 5.1 provides additional support 
for new features in iOS 9.3.

Reference 4.1  
OS X Server Benefits
Other solutions are capable of providing management for Apple devices, but at only 
$19.99 (US), not many of them are as inexpensive as OS X Server. Also, despite the 
price, because Apple develops OS X Server, it’s often the first management solution 
that supports the latest Apple management features and operating systems.

Further, even if you intend to use a third-party Mobile Device Management (MDM) 
solution, other services in OS X Server are still clearly the best solution. For example, 
the Caching service has no supported alternative. The NetInstall service that provides 
network system disk access for OS X computers is available from other servers, but 
the implementation in OS X Server is supported by Apple.

Lesson 4

OS X Server 5 on El Capitan

GOALS

▶▶ Perform the initial 
installation and config-
uration of OS X Server

▶▶ Consider TLS/SSL  
certificate requirements 
and best practices
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Services Covered in This Guide
Again, this guide focuses on the OS X services that are most responsible for helping 
administrators manage their Apple deployments:

▶▶ Caching service—As introduced previously, the Caching service greatly reduces 
Internet bandwidth used for the installation of Apple-sourced software and media. 
Lesson 5, “Caching Service,” focuses on the architecture, setup, and troubleshooting  
of this service.

NOTE ▶  OS X Server 5 still offers the legacy Software Update service. However, this 
older service is limited to providing updates for OS X system software and Apple soft-
ware installed from outside the Mac App Store. Because of this service’s limited use in 
contemporary Apple deployments, it’s not covered in this guide.

▶▶ Profile Manager—This is the name given to the MDM service provided by OS X 
Server. The vast majority of material in this guide deals directly with or is designed 
around MDM management workflows. Both Lesson 6, “Configuration and Profiles,” 
and Lesson 7, “Mobile Device Management,” cover Profile Manager specifically. In 
addition, nearly all lessons that follow these two deal with topics related to MDM 
services.

▶▶ NetInstall—This service makes OS X systems available for startup via a network 
connection. NetInstall is often used as a platform for installing or re-imaging Mac 
computers en masse. Coverage of this service is beyond the scope of this guide, but 
you can find out more from Apple Pro Training Series: OS X Server 5.0 Essentials on 
El Capitan (Peachpit Press, 2016).

▶▶ File Sharing—The local file-sharing service provided by OS X Server supports 
both iOS and OS X devices. The new option in Server 5, “Create personal folders 
when users connect on iOS,” is available for supported iOS apps (at the time of this 
writing: Keynote, Numbers, and Pages) with Server 5 on El Capitan (not available 
with Server 5 on Yosemite). Additionally, in the File Sharing pane, you can configure 
each shared folder to support WebDAV, and some iOS apps support WebDAV.

▶▶ Wiki—The OS X Server Wiki service not only provides a browser-based interface for 
collaborative document creation but serves as an alternative for local file sharing.

MORE INFO ▶  For more detailed coverage of OS X Server setup and services outside 
the scope of this guide, check out Apple Pro Training Series: OS X Server 5.0 Essentials 
on El Capitan (Peachpit Press, 2016).
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Reference 4.2  
OS X Server Setup
This section outlines the system requirements for OS X Server and presents suggestions 
for scoping server hardware. It also gives recommendations for network configuration of 
an OS X Server.

MORE INFO ▶  You’ll find more detailed step-by-step instructions for installing and 
configuring OS X Server in the exercises later in this lesson.

Verifying Server Hardware Requirements
OS X Server 5.1 is an app that runs on any Mac running El Capitan 10.11.4 with 10 GB of 
free disk space. Before you install OS X Server, confirm that your system meets at least the 
minimum hardware requirements. You can find this information on the label attached to 
the box of every Mac sold, or you can find it with the About This Mac and System Infor-
mation applications.

To run El Capitan, your Mac must be one of the following models or later:

▶▶ iMac (mid-2007 or later)
▶▶ MacBook (13-inch Aluminum, late 2008; 13-inch, early 2009 or later)
▶▶ MacBook Pro (13-inch, mid-2009 or later; 15-inch or 17-inch, mid/late 2007 or later)
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▶▶ MacBook Air (late 2008 or later)
▶▶ Mac mini (early 2009 or later)
▶▶ Mac Pro (early 2008 or later)
▶▶ Xserve (early 2009)

Some features of OS X Server require an Apple ID, and some features require a compatible 
Internet service provider.

Server Hardware Considerations
For the purposes of the exercises in this guide or any other deployment testing, you can 
run OS X Server on just about any contemporary Mac. In practice, however, consider the 
size of your Apple deployment and select hardware appropriate for your production needs:

▶▶ Memory—In general, more system memory results in better system performance, but 
exactly how much memory is ideal for your situation is impossible for this guide to 
prescribe. You can, however, get a good idea of system memory usage for an existing 
server from the Memory Usage and Memory Pressure statistics available in the Stats 
pane of the Server app. Obviously, if you observe extremely high memory usage, 
upgrading the Mac computer’s system memory is a good idea.
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▶▶ Storage—Be sure you have enough disk space to hold the data for the services you 
plan to offer. If the services you plan to offer are disk intensive (for example, the Wiki 
service with a high volume of user content), consider using a faster physical disk or 
even an external disk system. An external disk is especially useful for the Caching 
service since it can potentially fill an entire disk, and the more items that are cached, 
the more effective the service.

▶▶ Backup—You cannot re-create a lost MDM database because of the security 
architecture of the MDM service. Thus, if the data store for Profile Manager is lost, 
you will lose the ability to manage your Apple devices. The devices will retain existing 
management settings but will accept new management only when enrolled into a new 
MDM service. In short, you really need to back up your management server. OS X 
Server is fully supported by the Time Machine backup built in to OS X.

▶▶ Network interfaces—Be sure to consider the speed of the network interface when 
making a server hardware decision. Most Mac computers support Gigabit Ethernet. 
All Mac computers capable of running OS X Yosemite or El Capitan that include 
built-in Ethernet interfaces support Gigabit Ethernet. If your Mac is equipped with 
Thunderbolt interfaces, you can use Apple Thunderbolt to Gigabit Ethernet adapters 
to add Ethernet interfaces. All services, except for Caching and NetInstall, can 
operate from the Mac system’s Wi-Fi interface. But for performance reasons, it’s not 
recommended that you provide services via a Wi-Fi interface.

▶▶ Availability—To help ensure that OS X Server stays up and running, you can turn on 
the Energy Saver system preference “Start up automatically after a power failure” (not 
available on all Mac systems). It’s also recommended that you use an uninterruptible 
power supply (UPS) for your server, including any external volumes, to keep your 
server up and running in the case of a brief power outage.

Server Network Considerations
Again, for the purposes of completing exercises in this guide or for general testing, you 
can configure your server using whatever Internet Protocol (IP) address was set via 
Dynamic Host Control Protocol (DHCP) and even use the computer’s local Bonjour 
name. However, some services may be negatively affected if the server’s IP address or host 
name is changed.

 If you absolutely must change the name of your server, do so only via the 
server Overview settings in the Server app. On a computer running OS X Server, you 
should never change the name via Sharing preferences.
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For example, your MDM service must be resolvable on all managed devices to a single 
Domain Name System (DNS) host name. Managed devices communicate with the MDM 
service only via the single host name used during enrollment. In other words, if you want 
to change the DNS host name clients use to resolve the MDM service, you will have to 
reenroll all your devices with the new host name.

Given that changes to a server configuration can dramatically affect device management, 
it’s obviously best to select network settings that will remain appropriate throughout the 
duration of your deployment. Consider the following factors when configuring network 
access for your management server:

▶▶ IP address—Configuring a static IP address for your production OS X Server is highly 
recommended. The primary reason for this is to prevent accidental changes that 
would prevent the DNS host name of the server to become unreachable.

▶▶ Subnets—With the exception of two specific issues, most OS X Server services aren’t 
affected by subnet settings. First, if you don’t use a DNS host name and instead rely  
on the Bonjour local host name (often defined as something like computername.local), 
only devices on the local subnet will recognize your server’s local host name. Obviously, 
this issue can be resolved by configuring a “real” DNS host name. Second, the NetInstall 
discovery service broadcast doesn’t travel beyond the local subnet by default. Resolving 
this issue is detailed in Apple Support article PH15509, “Set up NetInstall service across 
subnets.”

▶▶ Computer name—The server’s computer name affects access to the server only from 
the local subnet. The computer name is often used to define the Bonjour local host 
name, which again is resolvable only on the server’s local subnet. For any server that 
needs to be reachable beyond the local subnet (that is, most servers), the computer 
name doesn’t really matter.

▶▶ DNS host name—A server’s DNS host name is how most clients will resolve access 
to almost all the services hosted on your server. You must coordinate with your 
DNS network administrator to make sure the server’s DNS host name is properly 
configured. Remember that OS X Server requires both a forward and reverse DNS 
host name record for proper setup.

▶▶ Network ports—The variety of services offered by your server use a range of both 
User Datagram Protocol (UDP) and Transmission Control Protocol (TCP) network 
ports. A properly configured firewall should allow traffic only for the necessary 
network ports. Thus, newly configured services often require changes to established 
network firewalls. You will likely have to work with the network firewall administrator 
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to open additional ports for managing Apple devices. Throughout this guide, when a 
specific service’s architecture is detailed, the required network ports will be included 
with the documentation.

MORE INFO ▶  Apple maintains a list of all the well-known network ports used by 
Apple products in Apple Support article HT202944, “TCP and UDP ports used by 
Apple software products.”

▶▶ Simple Mail Transfer Protocol (SMTP) relay—A variety of services in OS X Server 
will send email messages as part of their function. If your organization relies on an 
SMTP relay service for sending email messages, then you need to configure OS X 
Server to take advantage of this service.

MORE INFO ▶  For information about configuring OS X Server to use an SMTP 
relay, see Apple Support article HT202962, “OS X Server: Sending email invitations, 
notifications and alerts when an SMTP relay is required.”

External Access and Reachability Testing
Managed devices can receive management changes only if they can access your MDM ser-
vice. Thus, if you require that devices are able to receive management changes when they 
are outside your network or on the Internet, your network infrastructure will have to be 
properly configured to allow connections from outside your network to reach your server.

If your server is on an internal network that uses private IP addresses, as is the most com-
mon case, your network routing will need to be configured so that it forwards traffic from 
a public Internet IP address to your server. If this is the case, only the required specific 
TCP ports will likely be forwarded to your server. Obviously, coordinating with a network 
administrator will be required to properly configure network routing and firewall rules.

Another consideration if your server is to be accessed from the Internet is that the DNS 
host name must be resolvable to any host on the Internet. As covered previously, in most 
of these cases, your server will be accessible via an external public IP address that for-
wards to an internal private IP address. This type of IP forwarding also requires a DNS 
configuration—commonly known as split DNS—where a single host name resolves to the 
proper IP address both externally and internally.

In other words, even though your server uses a single DNS host name, devices in your 
network will resolve this host name to a private IP address; devices outside your network 
will resolve the same host name to a public IP address. Again, coordinating with a net-
work administrator is required to properly set up this type of DNS configuration.
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Properly testing external service reachability can be tricky because it requires that you 
have access to a test external network. Fortunately, reachability testing will help you deter-
mine whether your server is accessible to Internet clients. This testing service is turned on 
by default, and you can find the results in the server Overview tab in the Server app.

You can further verify reachability for specific services by clicking the Details button to 
the right of the reachability information. The reachability service works by instructing 
automated servers at Apple to try to contact your server. In the reachability detailed view, 
you can see what external IP address, public host name, and specific services are available. 
This information will be valuable for any network administrator who is trying to help you 
facilitate external access for your server.
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Reference 4.3  
TLS/SSL Certificates
Transport Layer Security (TLS) and its predecessor, SSL, are protocols for the secure 
transmission of data between hosts. More specifically, TLS/SSL technology is used to 
prove your server’s identity to client devices and to encrypt communication between your 
server and client devices. This encryption isn’t just recommended to secure OS X Server 
services; it’s required for any MDM service including Profile Manager. This section starts 
with the basics of TLS/SSL certificates and then provides recommendations for certificate 
best practices in regard to managing Apple devices.

Understanding Certificates
To enable TLS/SSL communications, you must configure your server with a TLS/SSL 
certificate (also referred to as simply a certificate). A certificate is a file that identifies 
the certificate holder. A certificate specifies the permitted use of the certificate and has 
an expiration date. This is why certificates must be renewed on a regular basis (most 
often annually).

Importantly, a TLS/SSL certificate also includes a public key infrastructure (PKI) public 
key. This public key is mathematically tied to a private key that is securely stored on the 
server. Data encrypted with one key can be decrypted only by using the other key. Thus, if 
you can decrypt data with one key, it proves that the data was encrypted with the other key.

To initiate secure TLS/SSL connections, client devices download the certificate (contain-
ing the public key) from your server. If a client can successfully verify the identity of the 
server from the certificate, it will use the public key to begin secure communications 
with the server. This raises the question, how exactly does a client device verify, or trust, 
a certificate?

The answer is that a certificate is verified by its digital signature. A certificate is either self-
signed or signed by a certification authority (also known as a certificate authority or, more 
simply, a CA). A self-signed certificate, as the name implies, doesn’t require the involve-
ment of other CAs; thus, OS X Server will automatically create a self-signed certificate 
during the setup process. You can use a self-signed certificate for most TLS/SSL services, 
but self-signed certificates created by OS X Server (and most other servers) are not trusted 
by Apple devices for MDM services.

In other words, if you need to manage Apple devices, you will need to configure a certifi-
cate that has been signed by a verifiable CA. Certificates used by servers are most often 
signed by an intermediate CA, which is a CA whose certificate is signed by another CA. 
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The PKI infrastructure allows for a hierarchical chain of certificates, commonly known as 
a chain of trust. For example, the following figure shows the chain of trust for https://www.
apple.com, which can be revealed in Safari by clicking the lock to the left of a web address:

The certificate for www.apple.com is signed by an intermediate CA with the name of 
Symantec Class 3 EV SSL CA–G3, and that intermediate CA is signed by a CA with the 
name of VeriSign Class 3 Public Primary Certification Authority–G5. You can follow a 
chain of certificates, starting with a signed certificate, up to the intermediate CA and end-
ing at the top of the chain. The certificate chain ends with a CA that signs its own certifi-
cate, which is called a root CA. But how does a device know whether it can trust a CA?

The answer is that trust has to start somewhere. iOS and OS X include a collection of root 
and intermediate CAs that Apple has determined are worthy of trust out of the box. By 
extension, your Apple devices also trust any certificate or intermediate CA whose certifi-
cate chain ends with one of these CAs.

Although you can’t directly inspect the list of root certificates included on iOS devices, you 
can on an OS X computer from the Keychain Access application. Open Keychain Access 
(in the Utilities folder). In the upper-left Keychains column, select System Roots. Note that 
in the following figure the bottom of the window states that, at the time of this writing, 
there are more than 180 trusted CAs or intermediate CAs by default in El Capitan.

https://www.apple.com
https://www.apple.com
http://www.apple.com


Reference 4.3 TLS/SSL Certificates    109

MORE INFO ▶  The Apple PKI website (https://www.apple.com/certificateauthority/) 
contains more information about the root certificates included with Apple devices. 
You can also find a complete list of trusted root certificates for iOS in Apple Support 
article HT204132, “Lists of available trusted root certificates in iOS,” and for OS X  
in article HT202858, “Lists of available trusted root certificates in OS X.”

Certificate Signed by an Open Directory CA
Again, any MDM service must use a TLS/SSL certificate signed by a trusted CA. This lim-
its you to one of two choices if using Profile Manager as your MDM service: a certificate 
signed by a widely trusted CA (as covered in the next section) or a certificate signed by 
your own local Open Directory CA. Fortunately, OS X Server makes this latter choice an 
easy option by automatically creating an Open Directory CA and signing your server’s 
TLS/SSL certificate during the creation of an Open Directory master.

NOTE ▶  Creating an Open Directory master is required to enable device manage-
ment for Profile Manager. In other words, you’re probably going to end up with an 
Open Directory CA even if you don’t use it to sign the server’s certificate.

https://www.apple.com/certificateauthority/
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NOTE ▶  Make sure your server’s host name is properly configured prior to creating 
an Open Directory master. The Open Directory CA will only automatically sign the 
certificate with a name that matches the host name of the server.

When creating an Open Directory master from the Server app, Setup Assistant will guide 
you through several screens. One of the setup screens allows you to enter organizational 
information. This information will be used to create an Open Directory CA that will then 
be used to sign an intermediate CA, which is then used to sign your server’s TLS/SSL cer-
tificate. This process will also create a code-signing certificate that will come in handy for 
verifying profiles, as covered in Lesson 6, “Configuration and Profiles.”

MORE INFO ▶  You can find detailed step-by-step instructions for creating an Open 
Directory master in the exercises later in this lesson.

Assuming you completed the Open Directory master creation before acquiring other cer-
tificates, the Server app will automatically configure all supported services to use the cer-
tificate signed by the Open Directory CA. You can verify this by simply navigating to your 
server’s default secure website, https://hostname, where “hostname” is the name of your 
server. You will still see a default web services page and can inspect the certificate used to 
protect the site (as of this writing, configuring your server as an Open Directory master 
starts the Websites service).
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You’ll note that even though a chain of trust has been created, you still have the funda-
mental problem that Apple devices, by default, do not trust your server’s Open Directory 
CA. In a managed environment, you can easily solve this problem by using a trust profile, 
also covered in Lesson 6, “Configuration and Profiles.”

In fact, deploying a trust profile is required for the enrollment of most MDM services, 
including Profile Manager. Thus, if you or your staff is going to be directly responsible for 
managing the enrollment of Apple devices, using a certificate signed by the Open Direc-
tory CA is a perfectly acceptable solution for most deployments.

Issues with an Untrusted Certificate
In some environments, using a certificate signed by an Open Directory CA is not the rec-
ommended solution. For example, your organization may require that all TLS/SSL services 
use certificates that meet a certain specification or are provided by a specific vendor.

Alternately, if your environment relies upon users self-enrolling their own devices, 
you don’t want the first user experience of your management solution to be a warning 
message. The following warning message appears on an unmanaged iOS device when 
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connecting for the first time to an MDM service using a certificate signed by an untrusted 
Open Directory CA:

Not only does this type of warning message make your management solution look sketchy, 
it means that you (and your users) can’t trust any connection made to your management 
server. In other words, when connecting from an unmanaged device, you will have no way 
of identifying a legitimate connection to your server from an illegitimate server acting as 
your server or a server that is attempting a man-in-the-middle attack.

Further, you don’t want to establish that it’s OK for your users to click Continue when 
presented with this warning. Quite to the contrary, you should be instructing them that 
accepting connections to unverified servers is extremely dangerous.

NOTE ▶  You can use a configuration profile to prevent the user of an iOS device 
from trusting an untrusted TLS certificate.

Certificate Signed by a Widely Trusted CA
If you determine that your server needs a certificate signed by a widely trusted CA, the 
Certificates pane of the Server app provides two main methods for configuration: getting a 
trusted certificate by generating a certificate-signing request (CSR) or importing an existing 
certificate identity.

NOTE ▶  At this point, when configuring OS X Server for managing Apple devices, 
you only need to acquire a standard TLS/SSL certificate, the kind that is commonly 
used to protect websites. Although a code-signing certificate can be used with an 
MDM service, it is not required to set up and use the service.
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Get a Trusted Certificate

It all starts in the Certificates pane of the Server app; the Add (+) button reveals a  
pop-up menu.

The Get a Trusted Certificate assistant will create a new certificate identity consisting of 
an unsigned certificate and a private/public key pair. After you enter contact information 
for the certificate, the system will present a CSR. You will need to copy and paste (or save 
to a text file) the CSR content. The act of providing a CSR to a CA vendor is the most 
common method for acquiring a certificate signed by a widely trusted CA.

At this point, you will need to identify a CA vendor. Your organization may already work 
with a CA vendor, so that will likely be your first choice. Otherwise, the only recommen-
dation is choosing a CA vendor that works with Apple devices. When selecting a CA ven-
dor, an obvious quick test is that an Apple device can establish a secure connection to the 
vendor’s website.

After acquiring a TLS/SSL certificate subscription from a CA vendor, you will need to give 
the vendor your server’s CSR. Most CA vendors will accept the CSR content via a simple 
paste into a website. After the CA vendor has validated and signed your certificate, the 
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vendor will return it to you as a download. The download will often include the CA ven-
dor’s intermediate and root certificates. Double-click the pending certificate in the Server 
app, and drag all certificates provided by the CA vendor into the appropriate area.

Import a Certificate Identity

The Add (+) button reveals a pop-up menu. From this menu, you can select the option to 
import a certificate identity. This option assumes you already have a valid certificate iden-
tity consisting of a signed certificate and a private/public key pair. This is often the case 
if your organization uses a centralized certificate repository or if your organization has a 
wildcard certificate that can be used for multiple services. The term wildcard means the 
certificate can be used with any host name inside a specific domain.

If this is the case, someone else has already done all the hard work for you and will pro-
vide you with the appropriate certificates and private/public key pair. Transporting a 
private key in the clear is dangerous, so the key is often stored in an encrypted document. 
Further, to make certificate identities easier to transport, this encrypted document will 
also contain all the appropriate certificates. The most common file types are .pfx and .p12, 
both of which share a similar encrypted format.

The person providing you with the certificate identity will also have to provide you with 
the encryption key used to protect the document containing the private key. Once you 
have all the certificate identity documents, simply drag them to the certificate import win-
dow in the Server app and then provide the encryption key.
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Exercise 4.1  
Prepare Your Mac to Install OS X Server for El Capitan

 ▶	 Prerequisites

▶▶ You’ll need a Mac computer that is qualified to run OS X Server, that has OS 
X El Capitan on its startup volume, and that does not yet have OS X Server 
installed and configured on its startup volume.

▶▶ Your own administrator Apple ID or the administrator Apple ID from  
Exercise 2.2, “Create Apple IDs.”

▶▶ Even though best practice calls for a PTR DNS record (reverse DNS record) to 
exist for the IPv4 address of your server computer, the exercises in this guide 
are written for use in a test network with Bonjour .local names, so there should 
be no PTR record for the primary IPv4 address of your server.

In this exercise, you will configure your server computer in preparation to install OS X 
Server on it.

You’ll use one of two options to configure a local administrator account, depending on 
whether you are performing these exercises independently or are in an instructor-led 
environment with a Mac computer that has already been set up.
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In both situations, you’ll use System Preferences to configure Network and Sharing prefer-
ences. You will also download the student materials that you’ll use throughout this class. 
Finally, you will apply any necessary system software updates.

Challenge
Set up your server computer with a unique computer name. Download the student 
materials.

Considerations
The exercises in this guide are written so that the individual reader and the student in the 
instructor-led environment have a similar experience.

In a production environment, it is best practice to use your server’s fully qualified domain 
name. However, to make the exercises possible for those who cannot provide appropriate 
DNS records to computers and devices on their test network, the exercises in this guide 
use your server’s Bonjour .local name instead of a fully qualified domain name.

Solution

Use Your Client Computer to Confirm Lack of PTR Records

Before you configure your server Mac, use your client Mac to confirm that your DNS 
service does not provide a PTR record defining a host name for the primary IPv4 address 
your server will use.

1	 On your client Mac, press Command–Space bar (or click the Spotlight icon in the 
upper-right corner of the screen) to reveal the Spotlight Search field.

2	 In the Spotlight Search field, enter Network Utility.

3	 Confirm that Network Utility is listed in the Top Hit section of the search results, and 
then press Return to open it.
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4	 Click the Lookup tab.

5	 In the “Enter an internet address to lookup” field, enter 10.0.0.n1 (where n is your 
student number; for example, student1 uses 10.0.0.11, student 6 uses 10.0.0.61, and 
student 15 uses 10.0.0.151).

6	 Click Lookup.

7	 If the result field contains the text “The operation couldn’t be completed,” there is no 
PTR record for your server’s primary IPv4 address. You can continue with the next 
section, “Configure OS X on Your Server Computer.”
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8	 If the result field contains a DNS name such as “servern.trainapple.com” (where n  
is your student number), the DNS server that you are using provides PTR records  
for your server’s primary IPv4 address. In an instructor-led environment, check  
with your instructor. If you are performing these exercises independently, check your 
DNS server entries.

For best results when you perform the exercises on your test network, the DNS ser-
vice for your server computer, your client computer, and your iOS device should  
not provide a PTR record for your server’s primary IPv4 address. If the DNS service 
does provide a PTR record for your server’s primary IPv4 address, here are two 
options you might try before continuing with the exercises in this guide:

▶▶ Configure your internal DNS server to not offer a PTR record for your server’s 
primary IPv4 address.

▶▶ Configure your test network’s DHCP service to use an external DNS service that 
does not offer a PTR record for your server’s primary IPv4 addresses.

After you make one of the suggested changes, perform the previous step 5 again.

If you cannot perform either of the previous options, perform the following to config-
ure your server to use a .local Bonjour name even though there is a PTR record avail-
able for its primary IPv4 address:

▶▶ After you install OS X Server, select your server in the Server app sidebar, click 
the Overview tab, click Edit next to the Host Name field, click Next to start Change 
Host Name Assistant, and select Local Network in the Accessing Your Server pane. 
Click Next, enter servern.local in the Host Name field, and then click Finish.
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For experienced administrators, if you must use your server’s fully qualified domain 
name instead of its Bonjour .local name, replace every instance of a Bonjour .local 
name with your server’s fully qualified domain name throughout all the exercises in 
this guide.

Configure OS X on Your Server Computer

Starting with a fresh installation of OS X is most convenient. If your Mac is at the Wel-
come pane when you turn it on, you can use the Option 1 section that follows. If you 
need to use an existing OS X system, skip to Option 2 so your Mac will be configured as 
expected for the rest of the exercises.

Option 1: Configure OS X on Your Server Computer with Setup Assistant

This option is necessary if your server computer has not already been set up, which is the 
situation in an instructor-led environment. If you are using a Mac with existing accounts, 
perform the steps in “Option 2: Configure an Existing OS X System for Your Server Com-
puter” instead.

Ensure that you have OS X El Capitan installed on your server computer. If it isn’t already 
installed, install it now using the App Store, the Recovery HD, or a method specified by 
your instructor, and then continue when you reach the Welcome pane.

In this section, you’ll step through the OS X Setup Assistant for the initial system configu-
ration of your server computer.

1	 Ensure that your computer is connected to a valid network connection, unless you 
plan to use Wi-Fi as your primary network connection.

2	 If necessary, turn on the Mac that will run OS X Server.

3	 At the Welcome screen, select the appropriate region, and click Continue.

4	 Select the appropriate keyboard layout, and click Continue.

Setup Assistant evaluates your network environment and tries to determine whether 
you are connected to the Internet. This can take a few moments.

5	 If you plan to use Ethernet for your primary network connection and are not asked 
about your Internet connection, your computer’s network settings have already been 
configured via DHCP, and you may skip to step 8.
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If you plan to use Wi-Fi for your primary network connection and are at the Select 
Your Wi-Fi Network screen, select an appropriate Wi-Fi network, provide the Wi-Fi 
network’s password if necessary, click Continue, and skip to step 8.

6	 If you are at the How Do You Connect screen, select Local network (Ethernet), and 
click Continue.

7	 If you are at the Your Internet Connection screen, leave the settings at their defaults, 
and click Continue.

NOTE ▶  If no DHCP service is available or your network is not connected to the 
Internet, you will see the warning message “Your Mac isn’t connected to the internet.” 
In this case, click Try Again, configure your router to provide DHCP service, and 
make sure your network is connected to the Internet. Then click Continue in the Your 
Internet Connection pane. For advanced users on a network without DHCP, you can 
set your TCP/IP connection type to Manually, configure settings appropriate for your 
network, and then click Continue in the Your Internet Connection pane.

8	 When asked about transferring information to this Mac, select “Don’t transfer any 
information now,” and click Continue.

9	 If the Enable Location Services screen appears, select “Enable Location Services on 
this Mac,” and click Continue.

10	 At the Sign in with Your Apple ID screen, select “Don’t sign in,” click Continue, and 
then click Skip to confirm that you want to skip signing in with an Apple ID.

Note that if you do provide Apple ID credentials, some figures in upcoming exercises 
may look slightly different, and there may be extra steps. In an instructor-led environ-
ment, entering an Apple ID at this time is not recommended.

11	 At the Terms and Conditions screen, read the terms and conditions, and click Agree; 
then in the dialog to confirm that you have read and agree to the OS X software 
license agreement, click Agree.

Create your local administrator account.

NOTE ▶  Make sure you create this account as specified here. If you do not, future 
exercises may not work as written. Highlighted text is used throughout this guide to 
indicate text you should enter exactly as shown.
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1	 At the Create Your Computer Account screen, enter the following information:

▶▶ Full Name: Local Admin

▶▶ Account Name: ladmin

▶▶ Password: ladminpw

▶▶ (verify field): ladminpw

▶▶ Hint: Leave blank.
▶▶ Deselect the checkbox “Set time zone based on current location.”

If you are performing the exercises independently and if your server is accessible from 
the Internet, you can select a more secure password for the Local Admin account. Be 
sure to remember the password you have chosen because you will need to reenter it 
periodically as you use this computer.

If you are performing the exercises independently, you may provide a password hint if 
you want.

If you entered your Apple ID, you can select or deselect the checkbox “Allow my Apple 
ID to reset this user’s password”; it does not have a major effect on the exercises.

NOTE ▶  In a production environment, always use a strong password.

2	 Click Continue to create the local administrator account.

3	 At the Select Time Zone screen, click your time zone in the map or choose the nearest 
location in the Closest City pop-up menu, and then click Continue.

4	 At the Diagnostics & Usage screen, leave selected “Send diagnostics & usage data to 
Apple” and “Share crash data with app developers,” and then click Continue.

Please skip the Option 2 section, and continue at the section “Set the Computer Name.”

Option 2: Configure an Existing OS X System for Your Server Computer

This option is designed only for those who are performing the exercises independently 
and who have a computer that is already set up with an existing administrator account.

NOTE ▶  You may not use a Mac whose startup volume has already had OS X Server 
installed.
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If your computer has not been set up (that is, if the initial administrator account has not 
been created), perform the steps in “Option 1: Configure OS X on Your Server Computer 
with Setup Assistant” instead.

Create a new administrator account in System Preferences.

1	 If necessary, log in with your existing administrator account.

2	 Open System Preferences.

3	 In System Preferences, open Users & Groups.

4	 In the lower-left corner, click the lock icon.

5	 In the dialog that appears, enter the password for your existing administrator account, 
and then click Unlock.

6	 Click the Add (+) button under the user list.

7	 In the dialog that appears, use the following settings:

NOTE ▶  Make sure you create this account as specified here. If you do not, future 
exercises may not work as written. If you already have an account named Local 
Admin or ladmin, you will have to use a different name here and then remember to 
use your substitute name throughout the rest of the exercises. Highlighted text is used 
throughout this guide to indicate text you should enter exactly as shown.

▶▶ New Account: Choose Administrator.
▶▶ Full Name: Local Admin

▶▶ Account Name: ladmin

8	 If necessary, select “Use separate password.”

9	 If your server is not accessible from the Internet, enter ladminpw in the Password and 
Verify fields.

If you are performing the exercises independently, you can select a more secure pass-
word for the Local Admin account. Be sure to remember the password you have cho-
sen because you will need to reenter it periodically as you use this computer.

You may provide a password hint if you want.
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If you entered your Apple ID, you can select or deselect the checkbox “Allow my Apple 
ID to reset this user’s password”; it does not have a major effect on the exercises.

NOTE ▶  In a production environment, always use a strong password.

10	 Click Create User.

11	 At the bottom of the user list, click Login Options.

12	 If an account is selected for Automatic Login, use the pop-up menu to switch it to Off.

13	 Quit System Preferences, and log out.

14	 At the login screen, select the Local Admin account, and enter its password (ladminpw, 
or whatever you specified earlier).

15	 Press Return to log in.

This is the end of Option 2; everyone should continue with the next section.

Set the Computer Name

You will specify a computer name associated with your student number. If you are per-
forming the exercises independently, you can choose to skip this section.

1	 Open System Preferences.

2	 Open Sharing.

3	 Set Computer Name to servern, replacing n with your student number.

For example, if your student number is 17, the computer name should be server17 (all 
lowercase and no spaces).

4	 Press Return.
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Notice that the name listed under the Computer Name field, which is the local host 
name, updates to match your new computer name.

Turn On Remote Management

Enable Remote Management, which will allow the instructor to observe your computer, 
control your keyboard and mouse, gather information, copy items to your computer, and 
otherwise help you if necessary.

NOTE ▶  Even though you know administrator credentials for other students’ com-
puters and have the technical ability to remotely control their computers, please do 
not use that ability to interfere with their classroom experience.

1	 Click somewhere over the phrase “Remote Management,” but don’t select the  
checkbox yet.

2	 For “Allow Access for,” select “Only these users.”

3	 Click the Add (+) button, select Local Admin, and click Select.

4	 In the dialog that appears, hold down the Option key while selecting the Observe 
checkbox, which selects all the checkboxes.

5	 Click OK.

6	 Select the checkbox Remote Management.

7	 Confirm that the Sharing pane displays the text “Remote Management: On” and dis-
plays a green status indicator next to the text.

8	 Click Show All (looks like a grid) to return to the main System Preferences pane.

Configure Network Interfaces

It is best practice to configure your network settings before you initially install and configure 
OS X Server. To keep the setup as simple as possible for all situations, for this course your 
Apple devices will access your server’s services via Bonjour, rather than via DNS names.

NOTE ▶  The exercises are written for only one network interface to be active, but 
using multiple network interfaces will not significantly impact your ability to com-
plete the exercises.
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1	 In System Preferences, click Network.

2	 In the instructor-led environment, configure your Mac computer’s built-in Ether-
net port (or its Thunderbolt to Ethernet adapter port) to be the only active network 
service.

If you are performing the exercises independently, you may leave additional interfaces 
active, but be aware that this may cause differences between the way the exercises 
describe the windows and what you actually see.

In the list of network interfaces, select each network interface that you will not use in 
the exercise (which should be all interfaces except one Ethernet port), click the Action 
(gear icon) pop-up menu, and choose Make Service Inactive.

3	 If you will use multiple network interfaces, click the Action (gear icon) pop-up menu, 
choose Set Service Order, drag the services to an appropriate order so that your pri-
mary interface is at the top of the list, and click OK.

4	 Select the network interface you chose earlier in this exercise.

5	 Click Advanced.

6	 Click the TCP/IP tab.

7	 In the Configure IPv4 pop-up menu, choose Manually.

8	 In the instructor-led environment, enter the following information to manually con-
figure the Ethernet interface (IPv4) for the classroom environment:

IP Address: 10.0.0.n1 (where n is your student number; for example, student1 uses 
10.0.0.11, student 6 uses 10.0.0.61, and student 15 uses 10.0.0.151)

Subnet Mask: 255.255.255.0

Router: 10.0.0.1
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If you are performing the exercises independently and choose to use different network 
settings, see the “Exercise Setup” section in Lesson 1.

9	 Click the DNS tab.

Even though you just switched Configure IPv4 from DHCP to Manually, you did not 
yet apply the change. Values assigned by DHCP are listed, but once you click Apply, 
those values will not remain unless you deliberately add them.

10	 In the DNS Servers field, click Add (+).

11	 In the instructor-led environment, enter 10.0.0.1.

If you are performing the exercises independently, enter the value or values appropri-
ate for your environment.

12	 If there are any other values in the DNS Servers field, select another value, and then 
click Delete (-) to delete the value; do this until 10.0.0.1 (or your desired values if you 
are performing the exercises independently) is the only value in the DNS Servers field.

13	 Click OK to save the change and return to the list of network interfaces.

14	 Review the settings, and then click Apply to accept the network configuration.

15	 Click Show All (looks like a grid) to return to the main System Preferences pane.



Exercise 4.1 Prepare Your Mac to Install OS X Server for El Capitan    127

Update Software

To take advantage of possible fixes and improvements, be sure that you’re running the 
most recent version of OS X. If a local Caching service is available, your Mac will auto-
matically use it.

1	 While still in System Preferences, open App Store preferences.

2	 Select the checkbox “Install app updates.”

3	 Select the checkbox “Install OS X updates.”

4	 If the button at the bottom of the window is Check Now, click Check Now.

If the button at the bottom of the window is Show Updates, click Show Updates.

5	 If you are in an instructor-led environment, ask your instructor what updates are 
appropriate to install; otherwise, if there are any updates, click Update All.

If there are no updates available, press Command-Q to quit the App Store, quit Sys-
tem Preferences, skip the rest of this section, and continue with the section “Down-
load the Student Materials.”

6	 If the “Some updates need to finish downloading before they are installed” dialog 
appears, click Download & Restart.

If the Restarting Your Computer notification appears, click Restart; after your Mac 
restarts, you will be automatically logged back in.

7	 Quit the App Store.

8	 Quit System Preferences.

Download the Student Materials

Some files are necessary for the completion of some of the exercises. You have already 
downloaded them to your client computer, but you should also have them available on 
your server computer. If you are in an instructor-led environment, you can use the Option 
1 section that follows. Otherwise, skip to Option 2.

Option 1: Download the Student Materials in the Instructor-Led Environment

If you are performing the exercises independently, skip to “Option 2: Download the Stu-
dent Materials for the Independent Reader.”
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If you are in an instructor-led environment, you will connect to the classroom server 
and download the student materials used for the course. To copy the files, you’ll drag the 
folder to your Documents folder.

1	 In the Finder, choose File > New Finder Window (or press Command-N).

2	 In the Finder window sidebar, click mainserver.

If Mainserver does not appear in the Finder sidebar, in the Shared list, click All, and 
then double-click the mainserver icon in the Finder window.

Because mainserver allows guest access, your client computer logs in automatically as 
Guest and displays the available share points.

3	 Open the Public folder.

4	 Drag the StudentMaterials folder to the Documents folder in the sidebar.

5	 Once the copy is complete, disconnect from mainserver by clicking Eject next to the 
Mainserver listing.

Skip the Option 2 section that follows, and resume with the section “Install the Server App.”

Option 2: Download the Student Materials for the Independent Reader

If you are in the instructor-led environment, skip this section.

If you are performing the exercises independently, copy the student materials from your 
client or download the materials from Peachpit’s site, and place them in your Documents 
folder.

If both of your Mac systems have AirDrop enabled, you can use AirDrop to copy the Stu-
dentMaterials folder from your client to your server computer. Click AirDrop in a Finder 
window on each Mac. On your client computer, open a new Finder window, open your 
Documents folder, drag the StudentMaterials folder to the picture for your server com-
puter in the AirDrop window, and then click Send. On your server computer, click Save. 
When the transfer has completed, open the Downloads folder, and drag StudentMaterials 
to your Documents folder in the Finder window sidebar. Finally, close the AirDrop win-
dow on your client computer and on your server computer.
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Another option is to use a removable disk. If you have a USB, FireWire, or Thunderbolt 
disk, you can connect it to your client, copy the StudentMaterials folder from your local 
administrator’s Documents folder to the volume, eject the volume, connect the volume to 
your server computer, and drag the StudentMaterials folder to your Documents folder in 
the Finder window sidebar.

Alternatively, you can download the files from Peachpit again using the following steps:

NOTE ▶  You registered this guide for the lesson files in Exercise 2.1, “Configure Your 
Client Mac.” If you have not already done so, see the section “Option 2: Download the 
Student Materials for the Independent Reader” in that exercise for details.

1	 Using Safari, open www.peachpit.com, and click the Account link or Account Sign In 
link at the top right of the home page to access your Peachpit account.

2	 Click the Registered Products tab and locate Managing Apple Devices: Deploying and 
Maintaining iOS 9 and OS X El Capitan Devices.

3	 Click the Access Bonus Content link to access the student materials.

4	 Click the Student Materials link to download the appropriate files to the Downloads 
folder (or whichever location you have selected in Safari Preferences) on your computer.

5	 In the Finder, choose File > New Finder Window (or press Command-N).

6	 Choose Go > Downloads.

7	 Double-click the StudentMaterials.zip file to decompress the file.

8	 Drag the StudentMaterials folder from your Downloads folder to your Documents 
folder in the Finder window sidebar. If you want, you can also place StudentMaterials 
in your Dock for easy access.

9	 Drag the StudentMaterials.zip file from your Downloads folder to the Trash in the 
Dock if necessary.

In this exercise, you used System Preferences and the Finder to configure OS X on your 
server computer in preparation to install OS X Server.

http://www.peachpit.com
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Exercise 4.2  
Install OS X Server for El Capitan

 ▶	 Prerequisite

▶▶ Exercise 4.1, “Prepare Your Mac to Install OS X Server for El Capitan”

Challenge
Now that you have OS X configured on your server computer, install OS X Server on your 
server computer and configure it so you can administer it remotely.

Considerations
Your server computer isn’t a server until you run and configure the Server app.

If you are a member of the Mac Developer Program or iOS Developer Program (available 
at https://developer.apple.com), you may obtain a free redemption code for OS X Server.

Solution

Install Server

In a production environment, it’s recommended to download the latest version of OS X 
Server from the App Store.

 If you’ve already purchased OS X Server, you must use the same Apple ID 
used for the original purchase to avoid being charged again.

If you are in an instructor-led environment, use the Option 1 section that follows. Other-
wise, you should skip to Option 2.

https://developer.apple.com
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Option 1: In the Instructor-Led Environment, Copy Server

In the instructor-led environment, the classroom server has the Server app available in the 
StudentMaterials folder; move the Server app to the Applications folder on your server 
computer with the following steps:

1	 In the Finder on your server computer, open a new Finder window, click Documents 
in the sidebar, open the StudentMaterials folder you downloaded, and then open the 
Lesson4 folder.

2	 Drag the Server app into the Applications folder in the sidebar.

Please skip the Option 2 section, and continue at the “Open Server” section that follows.

Option 2: For the Independent Reader, Download or Purchase Server in the App Store

If you are performing the exercises independently, use your own administrator Apple 
ID or the administrator Apple ID from Exercise 2.2, “Create Apple IDs,” to purchase or 
redeem a code for OS X Server from the App Store. This automatically places the Server 
app in your Applications folder. If you have already purchased the Server app, download 
it again from the Purchased tab in the App Store. If you have the Server app available on 
a removable volume, drag the Server app from your removable volume into your Applica-
tions folder.

Open Server

Once you have the Server app installed in the Applications folder, open the Server app.

1	 In your Dock, click Launchpad.

2	 You may need to swipe to the next page in Launchpad to see the Server app (hold 
down the Command key and press the Right Arrow key, or if you have a trackpad, 
swipe to the left with two fingers to get to the next page in Launchpad).

3	 Click Server to open the Server app.

4	 Keep the Server app in the Dock. Click and hold Server in the Dock, and then choose 
Options > Keep in Dock from the menu that appears.
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5	 In the “To set up OS X Server on this Mac, click Continue” pane, click Continue.

6	 Read and agree to the terms of the software license agreement.

7	 Ensure that “Use Apple services to determine this server’s Internet reachability” is 
selected, and click Agree.

8	 Provide local administrator credentials (User Name: Local Admin, Administrator Pass-
word: ladminpw), and click Allow.

9	 Wait while OS X Server for El Capitan configures itself.

10	 Close the Server Tutorials window.

After its initial installation, the Server app displays the Overview tab in the Server pane.

NOTE ▶  The public IPv4 address in the following figure is obscured intentionally.

You have successfully installed OS X Server.
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Configure Your Server to Allow Remote Access via the Server App

Configure your server so that you can administer it with the Server app on your client 
computer.

1	 In the Server app, click the Settings tab.

2	 Select the checkbox “Using Server app on a remote Mac.”

It’s recommended that you administer your server with only one instance of the Server 
app at a time; if you have the Server app open while logged in on your server, quit the 
Server app before opening the Server app on your client computer.

In this exercise, you used the Server app to configure your server with OS X Server, and 
you turned on remote access using the Server app.

Exercise 4.3  
Configure OS X Server for El Capitan

 ▶	 Prerequisites

▶▶ Exercise 4.2, “Install OS X Server for El Capitan”

▶▶ Text files from the student materials, which you obtained as part of 
Exercise 4.1, “Prepare Your Mac to Install OS X Server for El Capitan”

Challenge
Configure Apple Push Notifications. Configure and start services you will use for the rest 
of the course:

▶▶ Open Directory, including importing users and groups
▶▶ Mail
▶▶ Calendar
▶▶ Contacts
▶▶ Wiki
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Considerations
In the Server app’s list of services, Open Directory is hidden by default in a section of 
advanced services. The downloadable student materials contain user import files with 
eight users and a group import file with two groups.

Solution

Enable Apple Push Notifications

1	 If necessary, open the Server app, authenticate to your server, select your server in the 
Server app sidebar, and then click the Settings tab.

2	 If the Apple Push Notifications (APN) checkbox is not already selected, select it now.

3	 Enter your administrator Apple ID credentials.

4	 Click Get Certificate.

5	 After the Server app successfully creates and processes the Apple Push Notification 
service certificates and displays their shared expiration date, click Done.
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Configure Your Server as an Open Directory Master

In a production environment, you would definitely confirm or verify DNS records before 
configuring your server as an Open Directory master. However, because this environment 
uses Bonjour names, you can skip the usual DNS verification step.

1	 If the Server app does not display the list of advanced services, hover the pointer 
above “Advanced” in the sidebar, and then click Show.

2	 Click Open Directory.

3	 Click the On/Off switch to turn on the Open Directory service.

4	 Select “Create a new Open Directory domain,” and click Next.

5	 Configure a password; you can leave the “Remember this password in my keychain” 
option selected.

If your server is not accessible from the Internet, in the Directory Administrator pane, 
enter diradminpw in the Password and Verify fields, and click Next.

Of course, in a production environment, you should use a secure password.

6	 In the Organization Information pane, enter the appropriate information.

If the following fields do not already contain the information shown, enter it, and 
click Next:

▶▶ Organization Name: MDM Project n (where n is your student number)
▶▶ Admin Email Address: ladmin@servern.local (where n is your student number)
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7	 View the Confirm Settings pane, and click Set Up.

The Server app displays its progress in the lower-left corner of the Confirm Settings pane.

When the configuration is complete, the Server app displays the Servers section of the 
Open Directory pane, with your server listed as the master. It also displays any addi-
tional IPv4 addresses your Mac has in addition to your server’s primary IPv4 address 
(such as Wi-Fi).

Inspect the SSL Configuration

One of the benefits of configuring your server to be an Open Directory master is that it 
automatically creates a code-signing certificate for Profile Manager to use. Use the follow-
ing steps to inspect your server’s Secure Sockets Layer configuration:

1	 In the Server app sidebar, select Certificates.

Note that all the services are set to use the same certificate: servern.local certificate 
(where n is your student number), which is signed by your server’s OD intermediate CA.

2	 Double-click the servern.local certificate (where n is your student number).

3	 Inspect the details of the certificate.

4	 Scroll to the end of the certificate information, and note that Purpose is Server 
Authentication.

Note the Renew button for the certificate. When the renewal date approaches, the 
Server app automatically generates an expiration alert for the certificate, and the alert 
offers a Renew button. You don’t have to wait for the alert; you can use this button to 
renew the certificate at any time.

5	 Click OK to return to the list of certificates.
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6	 Double-click Code Signing Certificate.

7	 Scroll to the end of the certificate information, and note that Purpose is Code Signing.

8	 Click OK to return to the list of certificates.

Import Users into Your Server’s Shared Directory Node

To expedite the exercise, in the StudentMaterials folder is a text file with user accounts. 
This import file defines these users with a “net” password. Of course, in a production envi-
ronment, each user should have a unique password or passphrase that is secret and secure.

Import the accounts into your server’s shared directory node.

1	 In the Server app sidebar, select Users.

2	 Click the Action (gear icon) pop-up menu, and choose Import Users.

3	 In the sidebar, click Documents. Open StudentMaterials, and then open the Lesson4 
folder.

4	 Select the users.txt file.

5	 Click the Directory pop-up menu, and choose Local Network Directory.

6	 If directory administrator credentials are not automatically provided thanks to the 
keychain item, provide directory administrator credentials in the Admin Name and 
Password fields.

7	 Click Import.
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8	 At the “Importing users and groups may take several minutes. Are you sure you want 
to continue?” dialog, click Continue.

9	 After the import has completed, select Local Network Users from the pop-up menu, 
and confirm that there are eight new local network users.

NOTE ▶  If any of the users are listed as Limited or No Access, after the import has 
completed, choose View > Refresh.

You now have added eight local network user accounts.

Import Groups into Your Server’s Shared Directory Node

To expedite the exercise, you have two import files: one that defines some of the imported 
users as members of the Marketing group and another that defines users as members of 
the Engineering group.

1	 In the Server app sidebar, select Groups.

2	 Click the Action (gear icon) pop-up menu, and choose Import Groups.

3	 If necessary, in the sidebar, click Documents. Open StudentMaterials, and then open 
the Lesson4 folder.

4	 If necessary, select Local Network Directory from the Directory pop-up menu, and 
provide directory administrator credentials in the Admin Name and Password fields.

5	 Double-click the groups.txt file to start importing the file.
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6	 At the “Importing users and groups may take several minutes. Are you sure you want 
to continue?” dialog, click Continue.

7	 After the import has completed, select Local Network Groups from the pop-up menu, 
and confirm that there are two new local network groups, each containing four 
members.

You now have two new local network groups populated with the local network users you 
previously imported.

Configure and Start the Mail Service

Once you’ve configured the Mail service, you can use it in other parts of this guide for 
configuration profile examples and to mail VPP notification invitations. This is not a pro-
duction server, so to expedite the setup, you will disable virus and junk mail filtering.

1	 In the Server app sidebar, select Mail.

2	 Click Filtering Settings.

3	 Deselect the “Enable virus filtering” checkbox.

4	 Deselect the “Enable junk mail filtering” checkbox.

5	 Click OK to close the Mail Filtering pane.

6	 Under the Domains field, click the Add (+) button.

7	 In the Domain field, enter servern.local (where n is your student number).

8	 Press Command-B to display the accounts browser window.
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9	 Select an account in the accounts browser, and then press Command-A to select all 
users and groups.

10	 Drag the accounts to the field that lists the Members and Email columns.

11	 Press Command-B to hide the accounts browser window.

12	 Click Create.

13	 Click the On/Off switch to start the Mail service.

14	 Wait for the Mail service to become available (green status indicator in the Status field).

Verify the Mail Service

1	 Open Mail on either your server Mac or your client Mac.

2	 In the “Choose a Mail account provider” pane, select Other Mail Account, and click 
Continue.
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3	 In the Add a Mail Account pane, confirm that the import file includes an email 
address for your server, for example:

▶▶ Name: Barbara Green

▶▶ Email Address: barbara@servern.local (where n is your student number)
▶▶ Password: net

4	 Click Sign In. The pane will display the message “Unable to verify account name or 
password.”

5	 In the Incoming Mail Server and Outgoing Mail Server fields, enter servern.local 
(where n is your student number).

The User Name and Password fields should already be populated.

6	 Click Sign In.

7	 If you see the Verify Certificate window, click Show Certificate, select the “Always 
trust” checkbox, and click Connect.

8	 If necessary, enter the local administrator credentials, and then click Update Settings.

9	 In the “Select the apps you want to use with this account” pane, deselect Notes, and 
click Done.
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Send and Receive a Test Message

1	 Choose File > New Message.

2	 In the To field, enter barbara@servern.local (where n is your student number).

3	 Enter Test Message in the Subject field.

4	 Enter some text in the main body field.

5	 Click the Send button in the upper-left corner of the message.

6	 Confirm that the message is delivered. If necessary, choose Window > Message Viewer.

7	 Quit Mail.

Turn On the Calendar Service

To have another service available for the Settings for Everyone configuration profile, you 
can turn on the Calendar service.

1	 In the Server app sidebar, select Calendar.

2	 Click the On/Off switch to start the service.

You can leave all the settings at their defaults.

Turn On the Contacts Service

Using the Contacts service allows you to quickly look up information, such as email 
addresses, for the users hosted by your server.

1	 In the Server app sidebar, select Contacts.

2	 Select the checkbox “Allow users to search the directory using the Contacts 
application.”

3	 Click the On/Off switch to start the service.

You can leave all the other settings at their defaults.



Exercise 4.4 Configure Server on Your Client Computer (Optional)    143

Turn On the Wiki Service

By default, the Wiki service allows iOS users to edit files on the wiki using iWork.

1	 In the Server app sidebar, select Wiki.

2	 Click the On/Off switch to start the service.

You can leave all the other settings at their defaults.

3	 Quit Server.

In this exercise, you turned on Apple Push Notifications on your server computer, config-
ured the server as an Open Directory master, imported users and groups, and turned on a 
few key services.

Exercise 4.4  
Configure Server on Your Client Computer (Optional)

 ▶	 Prerequisites

▶▶ Exercise 4.3, “Configure OS X Server for El Capitan”

▶▶ Text files from the student materials, which you obtained as part of 
Exercise 4.1, “Prepare Your Mac to Install OS X Server for El Capitan”

Challenge
Install the Server app on your client computer, and prepare it to remotely administer your 
server computer.

Considerations
Your server does not allow remote administration by default.

If you attempt to remotely administer your server, you will get a message that your client 
computer does not trust the identity of the SSL certificate used by the server.
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Solution

Install the Server App

On your server computer, you ran the Server app to configure your server computer 
as a server. However, on your client computer, you can run the Server app to remotely 
administer your server.

Option 1: In the Instructor-Led Environment, Copy the Server App

In the instructor-led environment, the classroom server has the Server app available in 
the StudentMaterials folder; move the Server app to the Applications folder on your client 
Mac with the following steps:

1	 In the Finder on your client Mac, open a new Finder window, click Documents in  
the sidebar, open the StudentMaterials folder you downloaded, and then open the 
Lesson4 folder.

2	 Drag the Server app into the Applications folder in the Finder window sidebar.

Option 2: For the Independent Reader, Download or Purchase OS X Server  
in the App Store

If you are performing the exercises independently, you should have already purchased  
OS X Server by the time you completed Exercise 4.1. If this is the case, open the App Store 
from the Dock or from Recent Items under the Apple menu, sign in with the Apple ID 
you used to purchase OS X Server, and download OS X Server, which automatically places 
the Server app in your Applications folder. If you have already purchased the Server app 
and have it available on a removable volume, drag the Server app from your removable 
volume into your Applications folder.

Use the Server App to Administer Your Server

Using your client computer, open the Server app, connect to your server, and accept its 
SSL certificate.

1	 On your client computer, open the Server app.

NOTE ▶  Do not click Continue; otherwise, you will configure your client Mac  
to be a server.



Exercise 4.4 Configure Server on Your Client Computer (Optional)    145

2	 Click and hold Server in the Dock, and then choose Options > Keep in Dock from 
the menu that appears.

3	 Click Other Mac.

4	 In the Choose a Mac window, select your server, and click Continue.

5	 Provide the administrator credentials (Administrator Name: ladmin, Administrator 
Password: ladminpw).

6	 Select the “Remember this password in my keychain” checkbox so the credentials you 
provide will be saved in your keychain (a secure store of passwords) and so you will 
not need to provide credentials again.

7	 Click Connect.

Because your server is using a self-signed SSL certificate that has not been signed by 
a certificate authority your client computer is configured to trust, you’ll see a warning 
message that you are connecting to a server whose identity certificate is not verified.

NOTE ▶  In a production environment, you might want to address this situation as 
soon as possible by using Keychain Access on your server computer to configure your 
server to use a valid SSL certificate for the com.apple.servermgrd identity, which is 
used to communicate with a remote instance of the Server app. This is outside the 
scope of this guide.

8	 Click Show Certificate.

9	 Select the checkbox to always trust com.apple.servermgrd when connecting to  
your server.

10	 Click Continue.

11	 You must provide your login credentials to modify your keychain.

Enter your password (ladminpw), and click Update Settings.

After you click Update Settings, the Server app connects to your server.

12	 Quit Server.

In this optional exercise, you configured your client computer to remotely configure your 
server with the Server app.
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creating/verifying DEP 
administrator account, 
314–315, 317–318

creating VPP administrator 
account, 411–412

defining enrollment settings for 
assignments, 298–299

logging in with VPP administrator 
account, 414

managing VPP accounts, 386–387
Activation Lock

allowing, 365–366
behavior, 342–343
bypass code, 366–369

clearing with Profile Manager, 
349–350

defining assignment enrollment  
settings, 296

Find My Device and, 340–341
iCloud services and, 31–33
impact on administration,  

339–340
iOS device preparation limitations 

in Apple Configurator 2, 505
managing, 343–344
overview of, 339
on supervised device, 359–371
turning on, 344–348
on unsupervised device, 351–359

Active Directory, securing data in  
transit, 80

Activity Monitor, examining Caching 
service, 160–161

Ad hoc services, as traditional iOS and 
OS X sharing option, 647

Administration portal, Profile  
Manager, 176

Administrative tasks, Profile Manager, 
239–242

Administrators
activating DEP administrator 

account, 316
activating VPP administrator 

account, 413
authenticating, 418
configuring fresh OS X install on 

server, 120
creating DEP administrator 

account, 314–315
creating local administrator 

account, 45
creating new administrator 

account, 46–47, 122–123
creating/verifying administrator 

Apple ID, 53–55, 58–61
creating VPP administrator 

account, 411–412

defining assignment enrollment 
settings, 299

downloading profiles, 187–188
impact of Activation Lock on, 

339–340
logging in with VPP administrator 

account, 414
managing DEP administrators, 

279–282
mandatory skill requirements for 

book lessons, 8
third-party management solutions 

and, 706
verifying DEP administrator 

account, 317–318
ADP (Apple Deployment Program)

creating/verifying program agent 
account, 307–312

DEP service. See DEP (Device 
Enrollment Program)

program agent, 384
using Apple IDs, 606
verifying Apple IDs, 23
VPP service. See VPP (Volume 

Purchase Program)
AFP (Apple Filing Protocol), 72
AirDrop

ad hoc sharing for iOS devices, 647
downloading student materials, 128
prevent sharing organizational 

information over, 661
securing data in transit, 80

Airplane mode, turning on/off, 98
AirPlay, 69, 647
Amsys plc, installing/running Services 

Test app, 96
APNs (Apple Push Notification service)

Activation Lock using, 345
automatically pushing profiles, 244
confirming connectivity to, 91–93
device management 

requirements, 220
enabling, 134–135

Index
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inspecting pushed profiles, 
244–247

network service availability and, 74
pushing configurations and tasks, 

216–218
securing data in transit, 80–81

App Store
adding apps with VPP Apple ID, 

611–613
attempting install on restricted 

client Mac, 697–698
creating/verifying administrator 

Apple ID, 53–55
creating/verifying client Apple ID, 

56–58
downloading Apple Configurator 2,  

517
downloading apps from, 167
installing app that can read PDFs, 

673–674
installing OS X apps, 700
purchasing apps and books, 385
purchasing OS X Server, 131–132
testing Caching service, 159
updating iOS apps, 620
updating software, 49, 127
VPP and, 37, 375–376

Apple Configurator 2
Activation Lock behavior and, 343
backup and migration, 500–502
combining DEP or Apple School 

Manager with, 275
comparing versions of, 496–498
Console app, 162
creating an organization, 519–520
defining assignment enrollment 

settings, 296
defining MDM server, 521–523
deploying in-house apps and 

books to iOS devices, 465
erasing/resetting iOS devices, 341
examining preferences, 518
inspecting organization certificate, 

520–521
inspecting profile documents, 

172–173
installing, 506, 517
installing command-line tool, 

523–524
institutional use of Apple IDs, 25
limitations on device preparation, 

502–505
logistical considerations, 499–500
overview of, 495
performing initial configuration, 87
preferences, 511–516

preparing and supervising iOS 
devices, 498–499

redemption codes for purchased 
apps, 37–38

restoring/managing iOS 
workflows, 653–654

running for first time, 518
supervising devices, 15
views, 507–510

Apple Configurator 2, managing apps/
documents
adding apps, 609–611
adding documents, 615–617
adding in-house enterprise apps, 

613–614
Apple IDs and, 606–608
distributing in-house apps, 

638–643
distributing VPP apps. See 

VPP (Volume Purchase 
Program), distributing apps

exporting documents, 617–618
managing apps with VPP Apple 

ID, 611–613
overview of, 605
removing apps, 615
single app mode, 621–624
updating apps, 618–621
viewing apps, 615

Apple Configurator 2, managing iOS 
devices
automating, 556–560
backing up/restoring, 551–555, 

599–604
creating configuration profiles, 

560–565
creating/using blueprints, 545–546, 

576–599
organizing devices by groups, 

547–551
overview of, 525
preparing. See Preparing  

iOS devices, Apple  
Configurator 2

using configuration profiles, 
526–530

Apple Deployment Program. See ADP 
(Apple Deployment Program)

Apple Developer ID, 527, 559
Apple Developer Program, 25, 461
Apple Device Enrollment program. See 

Enrollment
Apple devices, introduction to guide

exercise setup, 4–8
learning methodology, 2–3
lesson structure, 3–4

online documentation, 8
prerequisites, 1–2

Apple Filing Protocol (AFP), 72
Apple IDs

activating DEP administrator 
account, 316

adding apps with personal ID, 
609–611

adding apps with VPP, 611–613
Apple Configurator 2 and, 

606–608
creating, 19–20
creating two, 52–53
creating/verifying administrator 

ID, 53–55
creating/verifying ADP agent 

account, 308–312
creating/verifying client ID, 56–58
DEP service enrollment and, 

278–279
deploying, 39–41
developing management plan 

for, 709
institutional use of, 25
licensing and, 375–376
managing, 20–22
mandatory requirement for 

completing book lessons, 5
overview of, 17–19
setting up iCloud, 26–28
setting up iOS device, 357–359
Setup Assistant and, 535
sharing, 23–24
updating iOS apps and, 620–621
using same ID for VPP and  

DEP, 384
using Setup Assistant without, 

672–673
verifying, 22–23
verifying access administrator 

access, 58–61
verifying DEP administrator 

account, 317–318
Apple Pay, 535
Apple Push Notification service. See 

APNs (Apple Push Notification 
service)

Apple Remote Desktop, 465–466
Apple School Manager

Activation Lock and, 348
assignment placeholders, 292–293
configuring assignments, 292
creating Apple IDs, 24
creating device groups, 293–294
defining assignment enrollment 

settings, 295–299
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enrollment limitations, 302–303
forcing continued enrollment in 

MDM service, 529
institutional use of Apple IDs, 25
overview of, 38–39, 274–276
preparing iOS devices via 

automated enrollment, 
536–540

restoring/managing iOS 
workflows, 654

rules for Apple IDs, 606
supervising devices, 498
verifying functionality, 299–302

Apple store, 20
Apple TV

Caching service support, 147–148
planning subnets, 69–70
preparing, 542–545

Apple USB Camera Adapter, 646
Apple websites, 20
AppleCare support, 88–89
Apps

assigning, 396–401, 427–428, 434
assigning/installing free OS X, 

699–700
attempting to install on restricted 

client Mac, 697–698
attempting to send document from 

unmanaged, 689–691
available from Apple stores, 375
confirming listing in Profile 

Manager, 423
deleting/reinstalling, 168–169
deploying, 428–432
inspecting availability, 450–452
inspecting available licenses, 

454–455
installing on iOS device, 441–442
iOS restrictions, 666–667
managed apps, 226, 381–383
Managed Distribution, 378
Managed Open In and, 660–661
managing. See Apple 

Configurator 2, managing 
apps/documents

manually installing, 409–410
MDM features, 216
purchasing, 390
purchasing free app for iOS device, 

418–420
purchasing free app for OS X 

computer, 422
purchasing free OS X app for 

VPP managed distribution, 
698–699

purchasing paid app for iOS 
device, 420–421

removing Managed Distribution 
apps, 407–408

restricting use, 446–449
revoking assigned, 401–402
sending document from managed, 

691–693
unassigning, 454

Apps, in-house
acquiring, 464
adding enterprise, 479–481, 

613–614
assigning enterprise, 481–482
deploying, 459, 464–466
deploying with Profile Manager, 

474–475
distributing via Apple 

Configurator 2, 638–643
enrolling, 476–478
examining Remote Management 

profile before saving/
installing, 482–484

managing, 468–471
preparing devices for, 475–476
pushing, 471–473, 484–485
removing, 487–488
running on client Mac, 485–487
unenrolling, 488–489
uploading to Profile Manager 

library, 467–468
Architecture

Caching service, 147
MDM, 215–216

Assets, recording asset information, 86
Assignment

apps, 396–401, 427–428, 434
books, 396–401, 435
configuring, 292
creating device groups from, 

293–294
defining enrollment settings for, 

295–299
of DEP devices, 288
of devices to MDM service, 

326–327
in-house apps, 466
in-house books, 466, 491
in-house enterprise app, 481–482
installing assigned apps on iOS 

device, 441–442
iOS devices to MDM service, 

423–424
placeholders, 292–293
revoking assigned apps, 401–402

unassigning apps, 454
unassigning in-house books, 

492–493
unassigning iOS devices, 334, 369, 

455–456
Assignment Mode, VPP, 379, 396–397
Authentication

securing data in transit, 78
verifying Apple IDs, 23
Wi-Fi, 69

Automated enrollment
effects of Prepare action, 572–574
preparing iOS device via DEP, 

566–572
preparing iOS devices via Apple 

Configurator 2, 536–540
Automated management, Apple 

Configurator 2
exporting Automator actions, 

558–559
installing Automation Tools, 556
using Automator actions, 556–558
using cfgutil command, 560

Automatic discovery, Caching  
service, 149

Automatic Login, 47
Automator

exporting actions, 558–559
installing, 556
using actions, 556–558

B
Backups

backing up iOS devices, 652–653
backing up OS X computers, 

654–656
to iCloud, 62–63
managing, 656–657
media lacking in iOS, 651
before recycling or disposal, 87
requirements for OS X services, 103
restoration workflows, 653–654
restoring iOS devices, 551–555, 602
supervising, 500–502

Bandwidth, for network infrastructure, 67
BIND (Berkeley Internet Name Domain), 

156–157
Blueprints, creating/applying

allowing enrollment for Everyone 
group, 592

applying to supervised iOS device, 
600–601

applying to your iOS device, 
583–588, 593–595
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challenges in, 576
considerations, 576–577
creating and configuring, 577–583
distributing VPP apps, 627–629, 

631–634
duplicating and modifying Prepare 

action, 589–592
Erase All Content and Settings, 

577, 588–589
overview of, 545–546
turning on MDM lost mode, 

595–599
wiping iOS device, 599

Bonjour, 69
Books

assigning, 396–401, 435
availability from Apple stores, 375
confirming list of purchased, 423
inspecting, 455
inspecting availability, 450–452
installing, 409–410
managed, 381–383
Managed Distribution, 378
purchasing, 390, 421–422
viewing on iOS device, 442–443

Books, in-house
acquiring, 464
adding, 490–491
assigning, 491
confirming on iOS device, 492
deploying, 459, 464–466
deploying with Profile  

Manager, 489
enrolling, 489–490
managing, 468–471
removing, 493–494
unassigning, 492–493
unenrolling, 493
uploading to Profile Manager 

library, 467–468
Brownouts, power, 83
Browsers

configuring Safari to open to 
Apple Support, 263–264

DEP service requirements, 277
BYOD ("bring your own device"), 39
Bypass code, Activation Lock, 349–350, 

366–369

C
Cables, Apple TV, 542
CacheWarmer, 163
Caching service

architecture of, 147
automatic discovery, 149

with complex networks, 151–152
configuration options, 157–158
confirming registration with 

Apple, 166
downloading apps, 167
editing permissions, 153–157
examining with Activity Monitor, 

160–163
finding suspected issues, 160
iCloud data, 30
monitoring, 158–159
as OS X service, 100
on private network, 149–151
requirements, 147–149
setting up, 152
testing, 159–160
turning on/verifying, 165
updating iOS apps over the air 

via, 620
verifying, 167–170

Caching Service pane, 167–168
CalDAV, 71
Calendars, 71, 142
CAs (certificate authorities)

issues with untrusted certificates, 
111–112

OD (Open Directory), 180
purchasing code-signing 

certificate, 174
signing certificate with Open 

Directory CA, 109–111
signing certificate with widely 

trusted CA, 112–114
verifying certificates, 107–108

Certificate-signing request (CSR), 
112–114

Certificates
configuring OS X Server, 107–109
importing certificate identity, 

114–115
issues with untrusted certificates, 

111–112
securing data in transit, 79
securing transmission, 107
signing with Open Directory CA, 

109–111
signing with widely trusted CA, 

112–114
cfgutil, 523–524, 560
Chain of trust, 108, 111
CIDR (Classless Inter-Domain  

Routing), 155
Classroom app, 624
Classroom feature, 11
Clients

configuration profile, 196–198

configuring. See OS X clients, 
configuring

configuring server on, 143–145
creating standard local account, 

694–695
enrolling, 476–479
enrolling in VPP, 431–432
enrolling using user portal, 

254–256
removing from management, 

268–269
restricting access to services, 

693–700
running OS X apps, 485–487
unenrolling, 488–489
verifying Caching service, 169–170

Cloud services. See also iCloud, 72–73
Code signing

comparing signed and unsigned 
profiles, 207

configuring Profile Manager for, 
206–207

inspecting profiles, 205–206
installing signed profiles, 210–211
installing unsigned modified 

profiles, 212–213
installing unsigned profiles, 

208–210
profiles, 174–176
turning on, 180

Collaboration services, 646–647
Command-line tool, 523–524, 560
Computer accounts. See also Accounts, 

45, 120–121
Computer name

server network considerations, 104
specifying, 47–48, 123–124

Configuration profiles
adding passcode to, 263
adding to blueprint, 580
applying blueprint to iOS device, 

586–587
comparing signed and unsigned 

profiles, 207–208
configuring Profile Manager for 

signing, 206–207
confirming, 262
creating/editing, 526–527
creating for groups, 201–202, 

261–262
creating for users, 194–195
creating with Apple Configurator 2, 

560–565
default, 178–179
downloading, 196–200
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downloading/installing updated, 
203–204

editing payload of, 184–185
inspecting unsigned profiles, 

205–206
installing signed and unsigned 

profiles, 210–213
installing with Apple  

Configurator 2, 528–530
limiting access to content/services 

on iOS devices, 662–664
MDM features, 216
modifying signed and unsigned 

profiles, 208–212
preparing iOS devices via 

automated enrollment, 
538–539

removing, 200, 204, 529–530
removing from downloads  

folder, 271
restoring backups, 554
restricting service access, 693–700
signing/unsigning, 527–528
types of profiles, 172
updating, 202–203

Connectivity, telnet confirming, 91–93
Console, Apple Configurator, 162, 166
Contacts, 71, 142
Cooling infrastructure, 85–86
Credentials. See also Apple IDs

applying blueprints, 594
Automated Enrollment, 539
clearing Activation Lock, 349
creating/verifying ADP agent 

account, 309–311
defining assignment enrollment 

settings, 296
logging into VPP administrator 

account, 414
preparing iOS devices, 331
setting up iOS device, 357–359

Credit card payment, 607
CSR (certificate-signing request), 

112–114
Customers, Apple focus on experience of. 

See also Users, 10

D
Data

backing up, 87
restoring, 554
secure erase, 88
securing data at rest, 76–77

securing data in transit, 78–81
Datagram Transport Layer Security 

(DTLS), 79
Delivery

Profile Manager and, 184
receiving, 86

DEP (Device Enrollment Program).  
See also Enrollment
activating administrator  

account, 316
Activation Lock and, 348
adding administrator account, 

314–315
adding MDM server, 319
adding placeholder to device 

group, 327–328, 361–362, 
567–568

adding public key to MDM server 
on DEP site, 321

adding servers, 283–286
allowing Activation Lock, 365–366
assigning devices, 288, 326–327, 567
assignment placeholders, 292–293
configuring assignments, 292
configuring Profile Manager  

for, 318
confirming device enrollment, 337
creating device groups for DEP 

placeholder records, 
323–325

creating device groups from 
assignments, 293–294

creating/managing device 
enrollment, 329–330

creating/verifying ADP agent 
account, 307–312

defining assignment enrollment 
settings, 295–299

deploying organization-owned 
devices, 40

enrolling in, 312–313
enrollment limitations, 302–303
exporting server’s public key, 320
forcing device to remain enrolled, 

529
inspecting configuration profiles, 

332–334
institutional use of Apple IDs, 25
integrating with Profile Manager, 

282–283
managing DEP administrators, 

279–282
managing devices, 288–292
managing servers, 286–287

overview of, 35–37, 274–276
preparing device using automated 

enrollment, 566–575
preparing devices with Apple 

Configurator 2, 536–540
preparing devices with Setup 

Assistant, 330–332, 336
Profile Manager support, 176
removing devices assigned to 

MDM server, 574
removing placeholders, 335
restoring/managing iOS 

workflows, 654
rules for Apple IDs, 606
service enrollment, 278–279
service requirements, 276–278
steamlining enrollment, 219
supervising devices, 15
supervision of devices, 498
unassigning devices, 334
verifying administrator account, 

317–318
verifying functionality, 299–302
wiping devices, 335

Deployment
DEP and, 35–37
of equipment to user or location, 87
in-house apps and books, 459, 

464–466
in-house apps with Profile 

Manager, 474–475
in-house books with Profile 

Manager, 489
managing with MDM, 258–259
options, 35
scenarios, 38–41
third-party management solutions 

and advanced, 706
VPP and, 37–38

Device Enrollment Program. See DEP 
(Device Enrollment Program)

Device Information, exporting in Apple 
Configurator 2, 550

Device placeholders. See Placeholders
DHCP (Dynamic Host Control Protocol)

configuring fresh OS X install, 120
configuring network interfaces, 126
mandatory requirements for 

completing book lessons, 7
server network considerations, 103

Digital signatures, verifying  
certificates, 107

Directory Services, 70
Disposal/recycling, devices, 87–88
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DNS (Domain Name System)
availability of Internet services, 

74–75
Caching service and, 151
configuring network interfaces, 

126
confirming connectivity to APNs, 

92
confirming PTR records, 116–119
server network considerations, 

104–105
Documents. See also Apple 

Configurator 2, managing  
apps/documents, 172–174

Downloading profiles
as administrator, 187–188
for client Mac, 196–198
for iOS device, 198–200
updating, 203–204
as user, 188–189

DTLS (Datagram Transport Layer 
Security), 79

Duplicating blueprints, 589–592, 
627–629

Dynamic Host Control Protocol. See 
DHCP (Dynamic Host Control 
Protocol)

E
EAS (Exchange ActiveSync), 71, 81
Editing

blueprints, 545–546, 577–583
configuration profiles, 527–528
duplicating blueprint, 589–592
tags, 547

El Capitan
configuring for OS X client, 42–43
configuring for OS X Server, 

133–134
verifying server hardware 

requirements, 101–102
Email

adding alternative address, 59–61
encouraging user enrollment in 

MDM, 223
network service integration, 71
sending VPP invitations, 403, 

435–436
EMM (Enterprise Mobility 

Management). See also MDM 
(Mobile Device Management), 263

Encryption
of backups, 553, 555
securing data at rest, 77
securing iCloud, 29

Energy Saver, system preferences, 103
Enrollment

activating DEP administrators, 316
Activation Lock and, 348
adding DEP administrators, 

314–315
adding MDM server, 319
adding placeholder to DEP device 

group, 327–328, 361–362
adding public key to MDM  

server, 321
adding servers, 283–286
adjusting settings, 567
allowing Activation Lock, 365–366
assigning devices, 288, 326–327
assignment placeholders, 292–293
associating network user with 

enrolled device, 440–441
of client Macs, 478–479, 695–696
configuring assignment, 292
configuring Profile Manager, 318
confirming enrolled devices, 

256–258, 337
creating device groups, 293–294, 

323–325
creating/managing, 329–330
creating/verifying ADP agent 

account, 307–312
defining assignment settings, 

295–299
in DEP, 276–279, 312–313
DEP and Apple School Manager 

and, 274–276
encouraging users, 223–226
exporting server’s public key, 320
inspecting device setup profile, 

332–334
integrating DEP with Profile 

Manager, 282–283
of iOS devices, 476–477, 489–490, 

675–676
of iOS devices using user portal, 

251–254
of iOS devices with MDM, 353–

355, 362–364, 366
limitations for DEP and Apple 

School Manager, 302–303
of Mac computer using user portal, 

254–256
Managed Distribution, 402
managing DEP administrators, 

279–282
managing DEP devices, 288–292
managing servers in DEP, 286–287
in OTA, 250–251
overview of, 218–219, 273

preparing iOS devices,  
330–332, 336

process of, 14–15
removing placeholders, 335
troubleshooting, 303–305
unassigning iOS devices, 334
unenrolling initiated by user, 

229–230
unenrolling iOS devices, 369–370, 

488–489, 493
unenrolling iOS devices from 

VPP, 456
unenrolling via OTA, 265–266
user-initiated, 222
using Apple Deployment 

Programs, 305–306
verifying DEP administrator 

account, 317–318
verifying DEP or Apple School 

Manager functionality, 
299–302

verifying VPP enrollment, 
405–406

via user portal, 226–229
in VPP, 313–314, 384–385
wiping iOS devices, 335

Enrollment profiles
options for enrolling in MDM 

service, 219
preparing Apple TV devices, 543
removing, 529–530
types of profiles, 172

Enrollment website, 223–224
Enterprise apps

adding in-house, 479–481, 613–
614, 638–640

assigning, 481–482
pushing to group, 484–485

Enterprise Mobility Management 
(EMM). See also MDM (Mobile 
Device Management), 263

Enterprise solutions, AppleCare, 89
ePub

acquiring digital publications, 375
acquiring in-house books, 464
managed books and, 382

Ethernet
caching server saturating  

interface, 161
configuring network  

interfaces, 125
configuring OS X on server, 120
network infrastructure and, 68–69
requirements for OS X services, 103
securing data in transit, 78

Everyone group, 592
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EWS (Exchange Web Services), 71
Exchange ActiveSync (EAS), 71, 81
Exporting

Automator actions, 558–559
device information, 550
documents from app to Mac, 

617–618
Extensible Markup Language (XML), 

173–174

F
FaceTime, 80–81
Family sharing, 24
Favorites group, searching for  

devices, 549
Fetch Device Location, MDM, 597–598
File services, 72
File sharing

Internet options for, 648–649
OS X services, 100
traditional options for, 645–647

File System, deploying apps and books to 
OS X computer, 465

File Transfer Protocol (FTP), 72
FileVault security, 77
Find My Device

Activation Lock and, 340–341
enabling, 356, 366
iCloud services, 31–33
recovery solutions, 82

FireWire, 129
Firmware, copying, 502
Folders, iOS, 72
FTP (File Transfer Protocol), 72

G
Gatekeeper security, 461–463, 559
Get Info, Apple Configurator, 549,  

615, 619
Gigabit Ethernet. See also Ethernet, 

103, 161
Groups

adding placeholder to, 327–328
allowing enrollment during Setup 

Assistant, 592
assigning in-house books, 491
creating configuration profile for, 

201–202, 261–262
creating for placeholders, 323–325, 

424–427
creating from assignments, 

293–294
creating profiles, 182–183
creating Wiki page for, 259–261

importing into server’s shared 
directory node, 138–139

organizing devices by, 235–236, 
547–551

pushing enterprise app to, 484–485
removing from Managed 

Distribution, 453

H
Hardware, OS X Server considerations, 

101–103
Heating, ventilation, and air conditioning 

(HVAC), 86
Help Desk, AppleCare, 89
Home screen, of iOS device

applying blueprint, 584, 587–588
configuring blueprint, 579–580
inspecting device management, 

636–637
overview of, 443–446
removing layout and restrictions 

profile, 454
HVAC (heating, ventilation, and air 

conditioning), 86

I
iBooks Author file, 464
iBooks Store

acquiring digital publications, 375
Caching service support, 147–148
managed books, 382
purchasing books, 385
testing Caching service, 159
VPP and, 37

iCloud
Activation Lock limiting device 

preparation, 505
Activation Lock working in 

conjunction with, 340
backing up and managing content, 

28–29
backing up device to, 62–63
backing up iOS devices, 652–653
caching personal data, 157
clearing Activation Lock, 349
creating Apple IDs, 20
family sharing and, 33–34
Find My Device and Activation 

Lock features, 31–33
managed distribution and, 382
network service integration, 72–73
saving configuration profiles, 527
securing, 29–30
setting up, 26–28

iCloud Drive, 72, 650–651
iMessage, 80–81, 223
In-house apps. See Apps, in-house
In-house books. See Books, in-house
Infrastructure

cooling, 85–86
developing management plan, 703, 

707–709
network infrastructure, 67–70
power infrastructure, 83–84
third-party management solutions 

and, 705
Installation Mode, VPP, 379, 398–399
Installation workflows (handling 

logistics), 86–87
Internet

DEP service requirements, 277
iCloud Drive storage service, 

650–651
mandatory requirements for 

completing book lessons, 6
network service availability, 74
planning network infrastructure, 70
sharing/storage options, 648–649

Internet Accounts, OS X system 
preferences, 649

Internet Protocol (IP), 74–75
Inventory

recycling/disposing of, 87
third-party management solutions 

and, 706
iOS Apple USB Camera Adapter, 646
iOS devices. See also Preparing iOS 

devices, Apple Configurator 2
access management. See Access 

management
adding in-house enterprise apps, 

479–480
adding placeholder to device 

group, 361–362
Apple Configurator 2 views, 

507–510
assigning in-house enterprise app 

to, 481–482
assigning to MDM service, 

326–327
associating network user with 

enrolled device, 440–441
backing up to iCloud, 62–63
backup solutions, 652–653
Caching service support, 147–148
comparing signed and unsigned 

profiles, 208
configuring Mail for network user 

on, 436–437
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confirming enrollment, 337
confirming in-house books on, 492
creating/applying blueprints. See 

Blueprints, creating/applying
creating groups for placeholders, 

424–426
DEP (Device Enrollment 

Program), 35–37, 276
deploying in-house apps and 

books, 464–465
deployment scenarios, 38–41
developing apps for, 460–461
disassociating user from, 455
downloading configuration profile, 

198–200
enabling Activation Lock, 355–357
enrolling, 251–254, 353–355, 

362–364, 489–490
enrollment limitations for DEP 

and Apple School Manager, 
302–303

erasing content and settings, 341, 
351–352, 362, 370

examining Remote Management 
profile before saving/
installing enterprise app, 
482–484

iCloud Drive, 650–651
iCloud in managed environments, 

26, 29
inspecting setup profile, 332–334
inspecting unsigned configuration 

profile, 206
installing assigned apps on, 

441–442
Internet sharing/storage options, 

648–649
iTunes syncing, 651–652
limitations on device preparation 

by Apple Configurator 2, 
502–505

Managed Distribution and, 378
managing backups, 656
managing home screen of, 

443–446
managing in-house apps and 

books, 468–471
overview of, 62
personal folders, 72
physical security, 76
preparing and supervising, 

498–499
preparing for Activation Lock, 

352–353
preparing for enrollment,  

330–332, 336

preparing for in-house apps, 
475–476

prerequisites for managing, 1–2
preventing unauthorized  

access, 340
purchasing free apps, 418–420
purchasing paid apps, 420–421
removing enterprise apps, 487–488
removing from management, 

266–268
removing settings, 454
resetting, 63–64, 329–330
restoration workflows, 653–654
setting up, 64–65
storage options for, 646–647
supervising, 16
troubleshooting enrollment, 

303–305
turning on Activation Lock, 

344–348
unassigning, 334, 369, 455–456
unenrolling, 369–370, 456, 488–

489, 493
viewing books on, 442–443
wiping, 335, 357, 364–365

iOS Direct Service Program, 90
IP addresses

Caching service and, 148–151
CIDR (Classless Inter-Domain 

Routing), 155
configuring network  

interfaces, 125
confirming connectivity to  

APNs, 92
confirming lack of PTR  

records, 116
external access of reachability 

testing for servers, 105
mandatory requirements for 

completing book lessons, 7
server network considerations, 

103–104
IP (Internet Protocol), 74–75
iPads. See also iOS devices

defining enrollment settings for 
assignments, 296

enabling Find My iPad, 366
estimating power needs, 84
Find My Device and Activation 

Lock features, 31–33
Shared iPad feature, 11

iPhones. See also iOS devices, 31–33, 84
iPods. See also iOS devices, 84
IPv4 addresses. See IP addresses
IT (information technology), 10–11

Item management, developing 
management plan, 704, 710–711

iTunes
acquiring apps, 375
Activation Lock behavior and, 342
adding documents to device via 

file sharing, 615–617
allowing VPP access to iTunes 

account, 438–439
Caching service support,  

147–148, 160
deploying in-house apps and 

books to devices, 464
iOS backup and, 652–653
managed distribution and, 382
managing apps with personal 

Apple ID, 610
syncing devices, 651–652
updating apps, 620

K
Kensington security slot, 75
Kerberos, 80
Keychain Access, 513

L
LDAP (Lightweight Directory Access 

Protocol), 70
Licenses

inspecting available app licenses, 
454–455

making purchases and, 394
managing, 24
reading agreement before 

distributing app, 625
VPP and, 376

Lightweight Directory Access Protocol 
(LDAP), 70

Local administrator accounts. See also 
Accounts, 45, 120

Locally attached drives, storage options, 
646–647

Location Services
applying blueprint to devices, 585, 

594, 600
effects of Prepare action on device 

using automated enrollment, 
572

restoring device from backup, 603
Setup Assistant and, 534

Lock screen, 572, 588, 596
Lock Screen Message payload, 564–565
Login, 47, 695
Logistics, developing management plan, 

703, 707–709
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Logs
examining Caching service, 

161–163
inspecting Push Diagnostics, 

95–96
verifying Caching service, 165, 

168–169
Lookup, confirming lack of PTR  

records, 117
Lost mode, MDM, 595–599

M
Mac App Store

adding apps with personal  
Apple ID, 609–611

authorizations when using Apple 
Configurator 2, 606–607

downloading Apple  
Configurator 2, 506

purchasing apps and books, 385
testing Caching service, 159
VPP and, 37

Mac computers. See OS X computers
Mail service

attempting to open apps that read 
PDFs, 681–685, 686–689

attempting to send document from 
unmanaged app, 689–691

configuring for network users, 
436–437

configuring for workgroups, 
669–671

configuring/starting, 139–140
Open In PDF, 680–681
sending/receiving test  

messages, 142
verifying, 140–141

Maintenance, developing management 
plan, 704, 711–712

Managed apps and accounts, 659–660
Managed Distribution

accepting invitations, 405
assigning apps and books, 396–401
configuring VPP, 416–417
confirming invitations, 439
editing payment information, 415
enabling, 433–434
installing apps and books, 409–410
integrating Profile Manager with 

VPP, 387–390
managed apps and books, 381–383
overview of, 377–381
removing apps from, 407–408
removing group from, 453
revoking assigned apps, 401–402

sending invitations, 402–404, 
435–436

uploading items to Profile 
Manager Library, 467

user enrollment, 402
verifying VPP enrollment, 

405–406
verifying VPP purchases, 395
VPP and, 37

Managed Open In
configuring, 661
restricting access with, 659–661
securing data in transit, 81
workflow, 667–693

Management concepts, Apple
Apple ID and, 17–19
Apple School Manager, 38–39
backing up and managing iCloud 

content, 28–29
creating Apple IDs, 19–20
customer experience and, 10
DEP and, 35–37
deployment options scenarios,  

35, 38–41
Find My Device and Activation 

Lock features, 31–33
institutional use of Apple IDs, 25
IT focus at Apple, 10–11
managing Apple IDs, 20–22
mobile device management, 14–15
overview, 9
profile use, 12–14
securing iCloud, 29–30
setting up iCloud, 26–28
sharing Apple IDs, 23–24
sharing iCloud service with family, 

33–34
supervising devices, 15–17
taking advantage of new features, 11
verifying Apple IDs, 22–23
VPP and, 37–38

Management plan. See Plan, management
Maps application, lost mode and, 598
MDM (Mobile Device Management)

adding passcode to configuration 
profile, 263

adding public key to server on 
DEP site, 321

adding server, 319
administrative tasks with Profile 

Manager, 239–242
Apple Push Notification service, 

216–218
architecture of, 215–216
assigning devices to, 326–327, 

423–424

associating devices with users, 
233–235

automatically pushing profiles, 244
comparing Apple Configurator 2 

with, 495
configuring Managed Open, 661
configuring Safari to open to 

Apple Support, 263–264
confirming configuration  

profile, 262
confirming enrolled devices, 

256–258
confirming passcode, 264–265
creating configuration profile for 

groups, 261–262
creating Wiki page for a group, 

259–261
defining server, 521–523
DEP service requirements, 277
deploying apps remotely, 607
deploying in-house apps and 

books, 465–466
enabling device management, 

220–222, 247–249
encouraging user enrollment, 

223–226
enrolling Apple TV devices, 

542–545
enrolling in, 14–15, 218–219
enrolling in OTA, 250–251
enrolling iOS devices, 251–254, 

353–355, 362–364
enrolling OS X computers, 

254–256
enrolling via user portal, 226–229
features, 216
importing device lists, 238–239
inspecting automatically pushed 

profiles, 244–247
inspecting devices, 231–233
inspecting placeholders, 270
installing in-house enterprise 

app, 614
integrating with VPP service, 388
lost mode, 82–83
managed distribution and, 

382–383
managing deployment, 39–40, 

258–259
managing devices, 219–220
My Devices user portal tasks, 242
network service availability, 74
organizing device, 243–244
organizing devices by groups, 

235–236
overview of, 215
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placeholders in Profile Manager, 
236–238

preventing removal of enrollment 
profile, 37

Profile Manager as MDM  
service, 176

remote locking and wiping, 81–82
removing configuration profiles 

from downloads folder, 271
removing iOS device from 

management, 266–268
removing OS X computer from 

management, 268–269
services using TLS/SSL  

certificates, 109
turning on lost mode, 595–596
unenrolling, 229–230, 265–266
using Managed Open In, 660

MDM server
adding, 319
adding public key on DEP site, 

521–523
assigning device to, 566–567
Automated Enrollment credentials 

for, 539
defining, 521–523
managing home screen layout 

payloads, 634–636
preparing iOS devices, 533,  

536–537, 566–567
removing iOS devices, 574
VPP tokens cannot be shared 

among, 627
Memory, 102, 157–158
Micro-USB cable, 542
Migration, with AppleConfigurator 2, 

500–502
Mobile Device Management. See MDM 

(Mobile Device Management)
My Devices user portal, 226–229, 242

N
NAT (Network Address Translation), 

148–151
NetInstall, OS X services, 100
Network File system (NFS), 72
Network Utility, 116–119
Networks

Caching service and, 149–152
configuring interfaces, 124–126
developing plan for  

infrastructure, 708
file sharing, 646–647
infrastructure, 67–70

inspecting Push Diagnostics log, 
95–96

interface requirements for  
OS X, 103

mandatory requirements for 
completing book lessons, 
6–7

OS X Server considerations, 
103–105

purchasing/running Push 
Diagnostic app, 93–95

purchasing/running Services Test 
app, 96–98

pushing network access, 225
service availability, 74–75
service integration, 70–73
telnet for confirming connectivity, 

91–93
verifying service availability, 90–91

NFS (Network File system), 72

O
Open Directory

configuring server as Open 
Directory master, 135–136

creating code-signing  
certificate, 180

device management requirements, 
219–220

issues with untrusted certificates, 
111–112

network service integration, 70
signing certificate with Open 

Directory CA, 109–111
Organizations, Apple Configurator 2, 

519–521
OS X clients, configuring

configuring existing system, 46
creating local administrator 

account, 45
creating new administrator 

account, 46–47
creating/verifying Apple ID, 56–58
downloading student materials, 

50–52
establishing student number, 

42–44
overview of, 41–42
specifying computer name, 47–48
turning on remote management, 

48–49
updating software, 49

OS X computers
acquiring in-house apps, 461–464

adding in-house app to iOS device, 
638–640

adding in-house enterprise apps, 
480–481

backup solutions, 654–656
Caching service support, 147–148
comparing signed and unsigned 

configuration profiles, 207
configuring client computer, 42–43
configuring existing system, 46, 

121–123
configuring fresh install of, 

119–121
cooling infrastructure, 86
creating device groups for Mac 

placeholder, 426–427
DEP and, 35–37
deploying in-house apps and 

books to, 465–466
developing OS X apps, 461–463
downloading configuration 

profiles, 196–198
enrolling client Macs, 478–479
enrolling in VPP, 431–432
estimating power needs, 84–85
Find My Device and Activation 

Lock features, 31–33
iCloud and, 26, 29
iCloud Drive, 650–651
inspecting unsigned configuration 

profile, 205–206
Internet sharing/storage options, 

648–649
Managed Distribution, 378
managing backups, 656–657
mandatory requirements for 

completing book lessons, 5
personal folders, 72
physical security, 76
preparing for use as server, 115
prerequisites for managing i OS X 

devices, 1–2
purchasing free app, 422
pushing enterprise apps to group, 

484–485
pushing in-house apps, 471–473
removing from device 

management, 268–269
restricting access to services, 

693–700
running apps on client Macs, 

485–487
storage options for, 647
troubleshooting enrollment 

process, 303–305
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unenrolling client Mac, 488–489
verifying Caching service, 169–170
verifying server hardware 

requirements, 101–102
OS X Recovery, 655–656
OS X Server

benefits of, 99–100
Caching service requirements, 148
configuring as Open Directory 

master, 135–136
configuring existing system on, 

121–123
configuring for El Capitan, 

133–134
configuring fresh install on, 

119–121
configuring network interfaces, 

124–126
configuring on client computers, 

143–145
configuring/starting Mail service, 

139–140
configuring with certificate, 

107–109
confirming lack of PTR records, 

116–119
downloading student materials, 

127–129
enabling APNs, 134–135
file sharing with, 646
hardware considerations, 102–103
importing certificate identity, 

114–115
importing users and groups into 

shared directory node, 
137–139

inspecting SSL configuration, 
136–137

installing, 130–133
issues with untrusted certificates, 

111–112
mandatory requirements for 

completing book lessons, 
5–6

network considerations, 103–105
preparing Mac computer for, 115
prerequisites for managing Apple 

devices, 1–2
securing transmission, 107
sending/receiving test  

messages, 142
services, 100
signing certificates, 109–114
specifying computer name, 

123–124

testing external access and 
reachability, 105–106

turning on Calendar and Contacts 
services, 142

turning on remote  
management, 124

turning on Wiki service, 143
updating software, 127
verifying hardware requirements, 

101–102
verifying Mail service, 140–141

OTA (over-the-air), 14–15, 177, 250–251

P
Pairing

allowing with Mac, 514
device preparation limitations, 503
preventing supervised devices, 662

Passcode
adding to configuration  

profile, 263
applying blueprint to iOS device, 

585–586, 595, 601
confirming, 264–265
creating configuration profile, 564
securing data at rest, 77
Setup Assistant, 535

Passwords
authenticating devices, 23
creating configuration profile, 

561–563, 564
creating new administrator 

account, 46–47
creating/verifying administrator 

Apple ID, 53–55
creating/verifying ADP agent 

account, 308–310
creating/verifying client Apple 

ID, 57
managing home screen layout 

payloads for group, 635
restoring backups, 553–554
setting up devices, 357–359

Payload, configuration profile,  
185–187, 561

Payment
creating/verifying administrator 

Apple ID, 54
creating/verifying client Apple 

ID, 57
credit option, 391–392
direct payment option, 390–391
editing payment information, 415

PayPal, 390

PDFs
acquiring digital publications, 375
acquiring in-house books, 464
managed books and, 382
print services and, 73

Permissions, Caching service, 153–157
Personal identification numbers  

(PINs), 77
Photos, adding to supervised device, 601
Physical logistics

cooling infrastructure, 85–86
developing management plan, 707
disposal/recycling, 87–88
estimating power needs, 84–85
installation workflows (handling 

logistics), 86–87
overview of, 83
power infrastructure, 83–84

Physical security, 75–76
PINs (personal identification  

numbers), 77
PKI (public key infrastructure), 79, 

107–108
Placeholders

adding new record to device 
group, 567–568

adding to device group, 327–328, 
361–362

assigning, 292–293
creating device groups for,  

323–325, 424–427
importing device lists, 238–239
inspecting, 270
in Profile Manager, 236–238
removing, 335, 369–370,  

488–489, 493
unenrolling and, 230, 456, 575

Plan, management
consider third-party solutions, 

704–706
define requirements, 701–704
developing, 706–712
overview of, 701

Ports, 70, 104–105
Power infrastructure, 83–85
Preferences, Apple Configurator 2

creating backup for supervised 
device, 602

duplicating device blueprint,  
590, 628

examining, 518
overview of, 511–516
preparing devices for manual 

enrollment, 532–534
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Preparing iOS devices, Apple 
Configurator 2
Apple TVs, 542–545
applying to blueprint, 545–546
automated enrollment, 536–540
automated enrollment via DEP, 

568–574
configuring blueprint, 580–583
duplicating blueprint, 589–592
manual enrollment, 532–536
overview of, 530–531
verifying Setup Assistant 

customizations, 540–542
Print services, 73
Profile Manager

acquiring public key from, 
284–285

adding passcode to configuration 
profile, 263

adding placeholders to device 
group, 327–328, 567–568

administrative tasks, 239–242
Apple Configurator 2 vs., 526
assigning apps and books, 379, 

396–401, 435
associating devices with users, 

233–235
automatically pushing profiles, 244
clearing Activation Lock, 349–350
components of, 176–177
configuring, 177–178
configuring for DEP, 318
configuring for signing 

configuration profiles, 
206–207

configuring for VPP, 410–411, 
416–417

configuring Managed Open  
In, 661

confirming configuration  
profiles, 262

confirming enrolled devices, 
256–258

confirming Managed Distribution 
invitations, 439

creating configuration profiles for 
groups, 201–202, 261–262

creating configuration profiles for 
users, 194–195

creating device groups 
placeholders, 323–325, 
424–427

creating profiles, 181–183
deploying in-house apps, 474–475
deploying in-house books, 489

device management requirements, 
219–220

distributing in-house apps, 
640–641

downloading profiles, 185–189
editing configuration profile 

payload, 185–187
enabling device management, 

220–222, 248–249
enabling Managed Distribution, 

433–434
enrolling iOS devices, 251–254
enrolling OS X computers, 

254–256
enrolling via user portal, 226–229
General settings, 184–185
identifying placeholders, 230
importing device lists, 238–239
inspecting app and book 

availability, 450–452
inspecting app licenses, 454–455
inspecting automatically pushed 

profiles, 244–247
inspecting devices, 231–233
inspecting profile documents, 

172–173
integrating with DEP, 282–283
integrating with VPP, 388–390
making purchases, 395
Managed Open In settings, 

685–686
managing Activation Lock, 

343–344
managing backups, 656
managing devices, 219
managing in-house apps and 

books, 468–471
managing network/home screen 

layout payloads, 634–636
organizing device management, 

243–244
organizing devices by groups, 

235–236
OS X services, 100
placeholders in, 236–238
preparing Apple TV devices, 543
preparing iOS devices, 532
pushing in-house apps, 471–473
removing Managed Distribution 

apps, 407–408
removing placeholders, 335
restricting access to services, 

696–700
revoking assigned apps, 401–402
sending VPP invitations, 402–404

single app mode, 623–624
turning on, 192–193
turning on Activation Lock, 

344–348
turning on MDM lost mode, 

596–598
unenrolling, 574–575
updating configuration profile, 

202–203
uploading in-house apps and 

books to Profile Manager 
library, 467–468

using Managed Open In with, 660
verifying VPP enrollment, 

405–406
wiping iOS devices, 335, 341

Profile Manager Library, 467–468
Profiles

cleaning up, 213–214
code signing, 174–176
comparing signed and unsigned, 

207–208
components of Profile Manager, 

176–177
configuring Profile Manager 

service, 177–178
configuring signing configuration 

profiles, 206–207
creating configuration profile, 

201–202
creating for users, 194–195
default configuration profile, 

178–179
downloading and confirming 

configuration profile, 
196–200

downloading as administrator, 
187–188

downloading as user, 188–189
downloading updated 

configuration profile, 
203–204

editing configuration profile 
payload, 185–187

examining Remote Management 
profile before saving/
installing iOS enterprise 
app, 482–484

General settings, 184–185
inspecting profile documents, 

172–174
inspecting setup profile, 332–334
inspecting unsigned configuration 

profile, 205–206
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installing signed and unsigned 
modified configuration 
profiles, 210–213

managing via, 12–14
managing Wi-Fi, 628–629
manually installing, 181, 190–191
modifying/installing signed and 

unsigned configuration 
profiles, 208–212

removing configuration profile, 
200, 204

removing home screen layout and 
restrictions profile, 454

turning on code signing, 180
turning on Profile Manager, 

192–193
types of, 172
understanding, 171
updating configuration profile, 

202–203
user and group, 182–183

Profiles & Device Management, 572, 595, 
636–637

Program agent, ADP, 307–312, 384
Provisioning profiles, 172
PTR records, DNS, 116–119
Public key infrastructure (PKI), 79, 

107–108
Public keys

acquiring, 284–285
adding to MDM server, 321
exporting server’s public key, 320

Purchased apps, redemption codes for, 
37–38

Push Diagnostic app, 93–96

Q
Queries, MDM device features, 216

R
RAM, effect on caching, 163
Recovery Key, verifying Apple IDs, 23
Recovery solutions, for lost devices, 

81–83
Recycling, physical logistics, 87–88
Redemption codes, for purchased apps, 

37–38, 376–377, 606
Remote access, configuring server  

for, 133
Remote Management

applying blueprint to iOS  
device, 595

effects of Prepare action on iOS 
device, 572–573

examining Remote Management 
profile before saving/
installing enterprise app, 
482–484

inspecting on iOS device, 636–637
turning on, 48–49, 124
verifying DEP or Apple School 

Manager functionality, 
301–302

verifying Setup Assistant 
customizations, 541–542

Replacement parts, self-service, 90
Restore

from backup, 551–555, 599–604
iOS workflow, 653–654

S
S/MIME, 29
Safari browser, configuring to open to 

Apple Support, 263–264
Scalability, of third-party management 

solutions, 705
School Information System (SIS), 38
Search, for devices in Apple  

Configurator 2, 547–549
Secure shell (SSH), 80
Secure Sockets Layer. See SSL (Secure 

Sockets Layer)
Security

creating configuration profiles, 
561–564

data at rest, 76–77
data in transit, 78–81
iCloud, 29–30
MDM features, 216
physical, 75–76
profile, 185
recovery solutions, 81–83
theft deterrence, 275

Self-service
support options, 90
third-party management solutions 

and, 706
Server app

configuring Profile Manager 
service, 177–178

configuring server as Open 
Directory master, 135–136

configuring server for remote 
access, 133

configuring server on client 
computer, 144–145

confirming Caching service, 160
creating Wiki page for a group, 

259–261

enabling APNs, 134–135
enabling device management, 

248–249
importing users and groups into 

server’s shared directory 
node, 137–139

inspecting SSL configuration, 
136–137

purchasing OS X Server, 131–132
Stats pane, 158–159
turning Caching service  

on/off, 152
Server Message Block (SMB), 72
Servers

adding DEP servers, 283–286
adding MDM server, 319
adding public key to, 321
defining with Apple  

Configurator 2, 521–523
exporting public key, 320
managing, 286–287
removing OS X restrictions, 700

Service logs, 161–163, 165
Service set identifiers (SSIDs), 68
Services. See also by individual services

developing management plan for, 
711–712

iOS restrictions to limit access to, 
662–664

OS X restrictions to limit access to, 
665–666

OS X Server, 100
restricting access with profile, 

693–700
Services Test app, 96–98
Set Up screen, Setup Assistant, 534
Settings app

device management and 
supervision, 12

inspecting installed profiles, 13
Internet services in iOS in, 648
resetting iOS device, 63–64

Setup Assistant
Activation Lock behavior and, 342
allowing group enrollment during 

setup, 592
configuring blueprint for iOS 

device, 582–583
configuring OS X on client, 42–43
configuring OS X on server, 

119–121
creating Apple IDs, 20
creating Open Directory  

master, 110
defining assignment enrollment 

settings, 297–299
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Diagnostics feature, 535
enabling Find My iPad, 366
enrolling devices with MDM, 

362–364
facilitating enrollment, 274–275
installing configuration  

profiles, 529
preparing iOS devices for 

enrollment, 330–332, 336
preparing iOS devices for in-house 

apps, 475–476
preparing iOS devices via 

automated enrollment, 
537, 540

preparing iOS devices via manual 
enrollment, 534–536

requesting Apple ID, 17–18
restoring/managing iOS 

workflows, 653–654
setting up iOS device, 64–65
troubleshooting enrollment 

process, 304–305, 541
using without Apple ID, 672–673
verifying customizations when 

preparing iOS device, 
540–542

verifying DEP or Apple School 
Manager functionality, 
299–302

Shared directory node, 137–139
Shared iPad feature, 11
Sharing

files. See File sharing
iOS restrictions, 662–664
OS X restrictions, 665–666

Signed profiles, 527–530
Single app mode

distributing in-house apps, 
640–641

for iOS device via Apple 
Configurator 2, 621–623

for iOS device via Profile Manager, 
623–624

stopping, 623
Single sign-on (SSO), 80
Siri, 535
SIS (School Information System), 38
SMB (Server Message Block), 72
SMTP (Simple Mail Transfer Protocol), 

105, 403
Software updates

configuring client Mac, 49
developing management plan 

for, 711

enrollment and, 275
preparing Mac to install OS X 

Server, 127
updating apps, 620–621

SSH (secure shell), 80
SSIDs (service set identifiers), 68
SSL (Secure Sockets Layer)

certificates for secure  
transmission, 107

inspecting configuration, 136–137
securing data in transit, 79

SSO (single sign-on), 80
Stats pane, Server app, 158–159
Storage

Internet options, 648–649
iOS restrictions, 662–664
OS X requirements, 103
OS X restrictions, 665–666
traditional options, 645–647

Subnets, 69, 104
Supervised iOS devices, 621–623
Supervision

with Apple Configurator 2, 498–
499, 533–534

backing up and restoring 
supervised device, 599–604

backup and migration and, 
500–502

configuring blueprint for iOS 
device, 582

creating configuration profile for 
iOS device, 564

defining assignment enrollment 
settings, 296

of iOS devices, 15–17
iOS restoration workflows and, 

653–654
modifying Prepare action on iOS 

device, 591–592
preparation limitations for iOS 

devices, 502–505
remote, 275

Support options
AppleCare, 88–89
developing management plan for, 

711–712
overview of, 88
self-service, 90

Syncing, iOS iTunes, 651–652
System deployment, 703, 710
System imaging, of iOS devices, 551
System Preferences

configuring network interfaces, 
124–126

creating new administrator 
account, 46–47, 122–123

creating standard local account on 
client Mac, 694–695

Energy Saver, 103
profiles, 12
setting computer name, 47–48
updating software, 49, 127

T
Tags

as addition to blueprint, 628
configuring blueprint for iOS 

device, 578–579
duplicating blueprint on iOS 

device, 590–591
organizing devices by, 547
searching for devices by, 547–549

TCP (Transmission Control Protocol), 
104–105, 403

Telnet, confirming connectivity, 91–93
Template iOS device, 555, 620
Terminal app, 91–93
Text, 580
Text messaging, 223
Theft deterrence, 275
"Think different," Apple design 

philosophy, 9
Third-party solutions

developing management plan with, 
704–706

Internet storage for iOS and  
OS X, 649

Share and Document Provider App 
Extensions for iOS 8, 649

Thunderbolt, 129
Time Machine

backing up OS X computers, 
654–655

backup and migration and, 
500–502

disabling access to, 657
TLS (Transport Layer Security), 79, 107
Touch ID, Setup Assistant, 77, 535
Training, developing management plan 

for, 709
Transmission Control Protocol (TCP), 

104–105, 403
Transport Layer Security (TLS), 79, 107
Troubleshooting Caching service

examining log files, 161–163
examining with Activity Monitor, 

160–161
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overview of, 159
testing, 159–160

Troubleshooting enrollment
overview of, 303–305
during setup, 541

Trust
creating between DEP and MDM 

services, 282
deploying trust profile, 111
types of profiles, 172

TXT records, DNS, 151, 156–157

U
UDP (User Datagram Protocol), 104–105
Unboxing equipment, 86
Uninterruptible power supply (UPS), 103
Unsigned profiles

creating, 528
installing on device, 528–530

Updates
of apps with Apple Configurator 2, 

618–619
apps with Software Update, 

620–621
developing management plan for 

software, 711
of software, 49, 127

UPS (Uninterruptible power supply), 103
Usage management, developing 

management plan, 703, 709–710
USB (universal serial bus)

connecting iOS device to OS X 
computer, 499–500

distributing to iOS devices via, 
606–607

downloading student  
materials, 129

preparing Apple TV devices, 542
User data and services

backup solutions, 652–656
iCloud Drive, 650–651
Internet sharing/storage options, 

648–649
iTunes syncing, 651–652
managing backups, 656–657
restoration workflows, 653–654
traditional sharing/storage options, 

645–647
User Datagram Protocol (UDP), 104–105
User portal

enrolling iOS devices, 251–254
enrolling Mac computers, 254–256, 

431–432
enrolling via, 226–229
Profile Manager, 177

removing client Mac from 
management, 268–269

removing iOS device from 
management, 266–268

tasks, 242
wiping iOS devices, 341

Users
Apple’s user centric philosophy, 10
associating devices with, 233–235
creating configuration profile for, 

194–195, 261–262
creating profiles, 182–183
disassociating from iOS device, 455
downloading profiles, 188–189
encouraging enrollment in MDM, 

223–226
importing into server’s shared 

directory node, 137–138
unenrolling from MDM, 229–230

V
View VPP Assignments, 612
Views, Apple Configurator 2

of apps on iOS device, 615
getting device information, 549
overview of, 507–510
sorting devices, 550–551

Virtual private networks (VPNs), 78–79
VPNs (virtual private networks), 78–79
VPP (Volume Purchase Program)

accepting Managed Distribution 
invitations, 405

account management, 386–387
acquiring tokens/configuring for, 

674–675
activating administrator account, 

413
adding apps, 611–613
administrator account and MDM, 

608
administrator account for Apple 

Configurator 2, 626–627
administrator account for 

multiple copies of Apple 
Configurator 2, 607

administrators, 281
allowing access to iTunes, 438–439
Apple stores and, 375–376
assigning apps, 396–401,  

427–428, 434
assigning books, 396–401, 435
assigning devices to MDM service, 

423–424
assigning managed apps that read 

PDFs, 678–680

associating network user with 
enrolled iOS device, 
440–441

configuring Mail service for 
network user, 436–437

configuring Profile Manager for, 
410–411

configuring with Profile Manager, 
416–417

confirming listing of purchased 
apps and books, 423

confirming Managed Distribution 
invitations, 439

creating administrator account, 
411–412

creating device groups for 
placeholders, 424–427

credit option, 391–392
deploying apps, 428–432, 608
deploying to user-owned  

devices, 39
direct payment option, 390–391
disassociating users from iOS 

device, 455
editing payment information, 415
enabling Managed Distribution, 

433–434
enrolling in, 278, 313–314
erasing content and settings, 

456–457
getting apps that read PDFs, 

677–678
inspecting app and book 

availability, 450–452
inspecting app licenses, 454–455
inspecting books, 455
installing assigned apps, 441–442
institutional use of Apple IDs, 25
integrating with Profile Manager, 

387–390
legacy redemption codes, 376–377
licensing and, 376
logging in with administrator 

account, 414
making purchases, 392–395
managed apps and books, 381–383
managed deployment, 621
Managed Distribution, 377–381
managing apps with Apple ID, 

611–612
managing home screen, 443–446
managing licenses, 24
manually installing apps and 

books, 409–410
overview of, 37–38, 373–374
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Profile Manager support, 176
purchasing apps and books, 390
purchasing free app for managed 

distribution, 698–699
purchasing free apps, 418–420, 422
purchasing free books, 421–422
purchasing paid app, 420–421
removing group from Managed 

Distribution, 453
removing iOS device settings, 454
removing Managed Distribution 

apps, 407–408
restricting app use, 446–449
revoking assigned apps, 401–402
rules for Apple IDs, 606–608
sending Managed Distribution 

invitations, 402–404, 
435–436

service enrollment, 384–385
unassigning apps, 454
unassigning devices, 455–456
unenrolling devices and removing 

placeholders, 456
verifying enrollment, 405–406
viewing books on iOS device, 

442–443
VPP website, 385–386

VPP (Volume Purchase Program), 
distributing apps
accepting Managed Distribution 

invitations, 405
adding apps to blueprint, 631–632
apply blueprint to iOS device, 

633–634

challenge/considerations, 625
confirming Managed Distribution 

invitations, 439
creating Wi-Fi profile, 629–631
duplicating blueprints, 627–629
enabling Managed Distribution, 

433–434
erasing content and settings, 633
inspecting iOS device 

management, 636–637
Managed Distribution, 377–381
managing network/home screen 

layout payloads, 634–636
purchasing free app for managed 

distribution, 698–699
removing group from Managed 

Distribution, 453
removing Managed Distribution 

apps, 407–408
sending Managed Distribution 

invitations, 402–404, 
435–436

sign to Apple Configurator 2, 
626–627

W
Wallpaper, 579, 587
Warranties, 88–89, 90
WebDAV, 72
Wi-Fi

applying blueprint to iOS device, 
585, 593, 600

configuring OS X install on  
server, 120

creating configuration profile, 
561–563

creating expiring profile, 628–629
effects of Prepare action using 

automated enrollment, 
572–573

inspecting iOS device 
management, 636

managing network/home screen 
layout payloads, 635

network infrastructure, 68
preparing iOS devices via 

automated enrollment, 
538–539

securing data in transit, 78, 80
Wiki service

creating Wiki page for a group, 
259–261

overview of, 100
turning on, 143

Wipe iOS devices, 335, 357, 364–365, 
367, 575, 599

Workgroup, Managed Open In settings, 
685–686

WPA/WPA2, 78

X
Xcode app, 460–463
XML (Extensible Markup Language), 

173–174

Z
Zoom option, Setup Assistant, 535
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